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บทคัดย่อ 

  
ข้อมูลดาวเทียม LANDSAT 8 ระบบ OLI แบนด์ 1-7 ณ วันที่ 3 ธันวาคม 2562 ได้ถูก

น ามาจ าแนกการใช้ประโยชน์ที่ดินใน 4 ประเภท พ้ืนที่การเกษตร  พ้ืนที่ป่าไม้ พ้ืนที่ชุมชนเมือง และ
พ้ืนที่น้ า โดยผลการจ าแนกการใช้ประโยชน์ที่ดินด้วยวิธีการจ าแนกข้อมูลแบบควบคุมและความน่าจะ
เป็นมากที่สุด พบว่าเทศบาลกาฬสินธุ์ที่มีขนาดพ้ืนที่ทั้งหมด 25.156 ตารางกิโลเมตร ปรากฏพ้ืนที่
เกษตรกรรม มีขนาดพ้ืนที่ 0.999 ตารางกิโลเมตร คิดเป็น 3.97% พ้ืนที่ป่าไม้ มีขนาดพ้ืนที่ 1.499 
ตารางกิโลเมตร คิดเป็น 5.96% พ้ืนที่ชุมชนเมือง มีขนาดพ้ืนที่ 22.258 ตารางกิโลเมตร คิดเป็น 
88.48% และพ้ืนที่แหล่งน้ า มีขนาดพ้ืนที่ 0.400 ตารางกิโลเมตร คิดเป็น 1.59% น าข้อมูลระบบ OLI 
แบนด์ที่  4-5 พร้อมกับข้อมูลระบบ TIRS แบนด์ที่ 10-11 มาหาค่าดัชนีพืชพรรณค่า Fractional 
vegetation cover (FVC) ค่า Land surface emissivity (LSE) และค่าอุณหภูมิสัมบู รณ์   แล้ว
น าเข้าสู่หลักการค านวณของ split -window เพ่ือหาค่าอุณหภูมิพ้ืนผิวของพื้นที่ ผลการศึกษาพบว่ามี
อุณหภูมิสูงสุดอยู่ที่ 37.55 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 22.67 องศาเซลเซียส และอุณหภูมิ
เฉลี่ยนอยู่ที่  30.11 องศาเซลเซียส จากการวิเคราะห์ความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยที่
ดาวเทียมตรวจวัดได้มีค่าเท่ากับ 37.55 องศาเซลเซียส และอุณหภูมิพ้ืนผิวเฉลี่ยที่กรมอุตุนิยมวิทยา
ตรวจวัดได้มีค่าเท่ากับ 38.50 องศาเซลเซียส เมื่อน ามาค านวณหาความคลาดเคลื่อนพบว่ามีค่าเท่ากับ 
2.46% 

 
ค าส าคัญ : ดัชนีความแตกต่างพืชพรรณ, ดาวเทียมแลนด์แซท 8 
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ABSTRACT 

  
LANDSAT 8 Satellite data in OLI systems band 1-7 on December 3, 2019 

have been classified into 4 types of land use: agricultural area, forest area, urban 
area and water resources area in supervised classification and maximum likelihood 
from Kalasin municipality with a total area of 25.156 square kilometers. The results 
show that agricultural area is 0.999 square kilometers or 3.97%, forest area is 1.499 
square kilometers or 5.96%, urban area is 22.258 square kilometers or 88.48%, and 
water resources area is 0.400 square kilometers or 1.59%. Data of the OLI system 
band 4-5 and data of TIRS system band 10-11 were calculated into fractional 
vegetation cover (FVC), land surface emissivity (LSE) and brightness temperature (TB) 
by split-window algorithm.  It is found that the highest temperature at 37.55 degrees 
Celsius, the lowest temperature at 22.67 degrees Celsius and the average 
temperature at 30.11 degrees Celsius. The relationship between the average surface 
temperature measured by satellites was analyzed as 37.55 degrees Celsius and the 
average surface that was measured by the Meteorological Department was 38.50 
degrees Celsius. In addition, the calculation of measurement error, it is found that 
2.46%. 
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บทที่ 1 
บทน า 

1.1 ที่มาและความส าคัญ 
ในปัจจุบันมีสภาพภูมิอากาศที่การเปลี่ยนแปลงอย่างต่อเนื่อง โดยเฉพาะการเพ่ิมขึ้นของ

อุณหภูมิ เฉลี่ยของโลกหรือภาวะโลกร้อน )Global Warming( แม้ว่าอุณหภูมิจะสูงขึ้นไม่กี่องศาแต่ก็
ท าให้ภัยพิบัติต่าง ๆ มีความรุนแรงขึ้น ไม่ว่าจะเป็นภัยแล้ง ไฟป่า อุทกภัยและวาตภัย ประเทศไทย
เป็นประเทศก าลังพัฒนาจนมีการเปลี่ยนแปลงการใช้ประโยชน์ที่ดิน จากเกษตรกรรมสู่ชุนชมเมือง
อุตสาหกรรมอย่างต่อเนื่อง การเพ่ิมขึ้นของชุมชนเมืองและอุตสาหกรรมเป็นสาเหตุหนึ่งที่ท าให้
อุณหภูมิของพ้ืนที่เพ่ิมขึ้น และมีส่วนท าให้เกิดปรากฏการณ์เกาะความร้อนของเมือง )urban heat 
island( ยิ่งมีการขยายตัวของชุมชนและอุตสาหกรรมมากขึ้นเท่าไร ก็ยิ่ งท าให้ อุณหภูมิและ
ปรากฏการณ์เกาะความร้อนขยายวงกว้างมากขึ้น ถึงแม้ว่าการเพ่ิมขึ้นของพ้ืนที่ดังกล่าวจะเป็นที่
ประจักษ์ในระดับโลก แต่ก็ไม่สามารถลดความต้องการของมนุษย์ได้ )ส านักงานนโยบายและแผน
พลังงาน, 2556( อุณหภูมิพ้ืนผิวดินเป็นอุณหภูมิในรูปแบบหนึ่งที่นิยมน ามาติดตามอุณหภูมิ โดยการ
ตรวจวัดความร้อนในช่วงคลื่นอินฟราเรดความร้อนที่อาศัยการแผ่รังสีความร้อนของสิ่งปกคลุมดินหรือ
พ้ืนผิวของโลกและสามารถบอกถึงอุณหภูมิในแต่ละสิ่งปกคลุมดินได้อย่างละเอียดและมีประสิทธิภาพ
รวมไปถึงมีความเหมาะสมในการน ามาใช้งาน ซึ่งปัจจุบันเทคโนโลยีภูมิสารสนเทศหรือที่รู้จักกัน ได้แก่ 
การรับรู้ จากระยะไกล )Remote Sensing: RS( ระบบสารสนเทศภูมิศาสตร์  )Geographic 
Information System: GIS( ระบบก าหนดต าแหน่งบนโลก )Global Positioning System: GPS( 
นั้นสามารถน ามาประมาณค่าอุณหภูมิพ้ืนผิวดินจากข้อมูลจากดาวเทียม LANDSAT-8 และยังสามารถ
พัฒนาเครื่องมืออัตโนมัติส าหรับโปรแกรม ArcGIS for Desktop ในการประมาณค่าอุณหภูมิพ้ืนผิว
ดิน จากข้อมูลดาวเทียมรวมไปถึงการศึกษาปรากฏการณ์เกาะความร้อนของเมืองได้อีกด้วย ใน
ปัจจุบันเทคโนโลยีภูมิสารสนเทศ สามารถน ามาประยุกต์ในการประมาณค่าอุณหภูมิพ้ืนผิวดิน )Land 
Surface Temperature( จากข้อมูลดาวเทียม LANDSAT-8 ระบบอินฟราเรดความร้อนและติดตาม
อุณหภูมิของพ้ืนที่ในเทศบาลเมืองกาฬสินธุ์ได้ ซึ่งปัจจุบันในงานวิชาการได้ให้ความส าคัญเกี่ยวกับเรื่อง
อุณหภูมิพ้ืนผิวเป็นจ านวนมาก และให้ความสนใจในการพัฒนาหลักการวัดอุณหภูมิพ้ืนผิวจากอวกาศ 
จะเห็นได้จากการพัฒนาสมการเพ่ือหาค่าอุณหภูมิพ้ืนผิว เช่น radiative transfer equation-based 
method, split window algorithm, single channel algorithm )Yu, X et al., 2014(  

โดยที่บางสมการจะใช้การค านวณด้วยช่วงคลื่นอินฟราเรดความร้อนเพียง 1 แบนด์ แต่เนื่อง
ด้วยปัจจุบันข้อมูลจากดาวเทียม LANDSAT- 8 มีช่วงคลื่นอินฟราเรดความร้อน จ านวน 2 แบนด์ 
ได้แก่ แบนด์ 10และแบนด์ 11 ดังนั้นจึงเลือกใช้หลักการ split-window เนื่องจากมีการน า 2 แบ
รนด์ มาค านวณร่วมกันในสมการเพ่ือค านวณค่าอุณหภูมิพ้ืนผิว )Rajeshwari, A. and Mani, N.D., 



 

 

  2 

2014) และมุ่งเน้นไปที่รูปแบบการใช้ประโยชน์ที่ดินเพ่ือหาพ้ืนที่การใช้ประโยชน์ที่ดิน หาค่าอุณหภูมิ
พ้ืนผิว พร้อมกับศึกษาความสัมพันธ์ระหว่างการใช้ประโยชน์ที่ดินกับข้อมูลจากดาวเทียม LANDSAT 
8 ซึ่งสามารถบันทึกข้อมูลในช่วง ความยาวคลื่นต่างๆได้แก่ ช่วงคลื่น Coastal aerosol (0.43-0.45 
ไมโครเมตร( ช่วงคลื่นสีน้ าเงิน )0.45-0.51ไมโครเมตร ( ช่วงคลื่นสีเขียว )0.53-0.59 ไมโครเมตร( ช่วง
คลื่นสีแดง )0.64-0.67 ไมโครเมตร( อินฟราเรดใกล้ )0.85-0.88 ไมโครเมตร( จ านวน 1 ช่วงคลื่น และ
อินฟราเรดคลื่นสั้น )1.57-1.65 และ 2.11-2.29 ไมโครเมตร ( จ านวน 2 ช่วงคลื่น ความละเอียดของ
จุดภาพ 30 เมตร ในช่วงคลื่นอินฟราเรดความร้อน )Thermal IR) จ านวน 2 ช่วงคลื่น ความละเอียด 
100 เมตร และภาพขาวด า )Panchromatic) ความละเอียด 15 เมตร ทั้งนี้ดาวเทียมแลนด์แซท 8 ยัง
มีระบบการเก็บข้อมูล ขนาด 16 บิต โคจรกลับมาถ่ายภาพซ้ าต าแหน่งเดิมทุกๆ 16 วัน 
 
1.2 วัตถุประสงค์ของการวิจัย 

1.  เพ่ือประมาณค่าอุณหภูมิพ้ืนผิวดินจากข้อมูลดาวเทียม LANDSAT-8 
2. เพ่ือศึกษาความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวดินและประเภทการใช้ประโยชน์ที่ดิน 

 
1.3 ประโยชน์ที่คาดว่าจะได้รับ 

1. ได้ทราบถึงสภาพการใช้ประโยชน์ที่ดินของจังหวัดกาฬสินธุ์ ปี 2556 - 2562 
2. ได้ทราบถึงความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวดินและประเภทการใช้ประโยชน์ที่ดิน 

 
1.4 ขอบเขตของการวิจัย 
 ท าการศึกษาในพ้ืนที่เทศบาลเมืองกาฬสินธุ์ จังหวัดกาฬสินธุ์ด้วยข้อมูลจากดาวเทียมแลนด์
แซท 8 
 
1.5 นิยามศัพท์เฉพาะ 

1. การประมาณค่า )Estimation) หมายถึง การประมาณค่าอุณหภูมิพ้ืนผิวดินด้วยการขจัด 
ปัจจัยต่าง ๆ ที่มีอิทธิพลต่อการสูญเสียพลังงานในช่วงคลื่นอินฟราเรดความร้อน เพ่ือให้ได้ค่าอุณหภูมิ
ที่มีความใกล้เคียงความเป็นจริงที่สุด 

2. อุณหภูมิพ้ืนผิวดิน )Land Surface Temperature) หมายถึง ความร้อนท่ีเกิดจากการแผ่รังสี 
ของวัตถุบนพ้ืนผิวโลกที่ตรวจจับได้ในช่วงคลื่นอินฟราเรดความร้อนจากข้อมูลจากดาวเทียม 
LANDSAT-8 

3. สภาพเปล่งรังสี )Emissivity) หมายถึง อัตราส่วนของพลังงานทั้งหมดที่แผ่รังสีของวัตถุจริง 
ใดๆหาด้วยพลังงานทั้งหมดที่แผ่รังสีของวัตถุดา มีค่าอยู่ระหว่าง 0-1 
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4. ปรากฏการณ์เกาะความร้อนของเมือง )Urban Heat Island) หมายถึง ปรากฏการณ์ที่สภาพ 
อากาศในบริเวณเขตเมืองจะมีแนวโน้มของอุณหภูมิที่สูงกว่าบริเวณชนบทข้างเคียง 

5. ระบบสารสนเทศทางภูมิศาสตร์ )Geographic Information System: GIS) หมายถึงระบบ 
คอมพิวเตอร์ที่มีความสามารถในการจัดเก็บ )Storage) จัดการ )Management) วิเคราะห์)Analysis) 
และแสดงผล )Display) ข้อมูลภูมิศาสตร์หรือข้อมูลเชิงพ้ืนที่ 

6. การรับรู้จากระยะไกล )Remote Sensing: RS) หมายถึง วิทยาศาสตร์หรือศิลปะของการ 
ได้มาซึ่งวัตถุพ้ืนที่หรือปรากฏการณ์จากเครื่องมือบันทึกข้อมูล โดยปราศจากการเข้าไปสัมผัสวัตถุ
เป้าหมาย ทั้งนี้อาศัยคุณสมบัติของคลื่นแม่เหล็กไฟฟ้า เป็นสื่อการได้มาของข้อมูลใน 3ลักษณะคือ 
ช่วงคลื่น )Spectral) รูปทรงสัณฐานของวัตถุบนพ้ืนผิวโลก )Spatial) และการเปลี่ยนแปลงตาม
ช่วงเวลา )Temporal)  
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บทที่ 2 
ทฤษฎีและงานวิจัยที่เกี่ยวข้อง 

 
2.1 ลักษณะโดยท่ัวไปของจังหวัดกาฬสินธุ์ 

 2.1.1 ลักษณะทางกายภาพ 
จังหวัดกาฬสินธุ์ตั้งอยู่ตอนกลางภาคตะวันออกเฉียงเหนือของประเทศไทย    มีพ้ืนที ่

จังหวัดรวมทั้งสิ้น 6946.746 ตารางกิโลเมตร หรือ 4,341,716 ไร่ จังหวัดกาฬสินธุ์ตั้งอยู่ระหว่างเส้น
ละติจูด )เส้นรุ้ง(ที่ 16-17 องศาเหนือและลองติจูด )เส้นแวง( ที่ 103-105 องศาตะวันออก ห่างจาก
กรุงเทพมหานคร โดยทางรถยนต์ประมาณ 419 กิโลเมตร มีอาณาเขตติดต่อกับจังหวัดใกล้เคียง  ดังนี้ 

ทิศเหนือ ติดต่อกับจังหวัดสกลนครและจังหวัดอุดรธานีโดยมีล าน้ าปาวและห้วยล าพันซาด 
ทิศใต ้ ติดต่อกับจังหวัดร้อยเอ็ดและจังหวัดมหาสารคาม 
ทิศตะวันออก ติดต่อกับจังหวัดสกลนครและจังหวัดมุกดาหาร  
ทิศตะวันตก ติดต่อกับจังหวัดมหาสารคาม และบางส่วนติดต่อกับจังหวัดขอนแก่น 

2.1.2 ลักษณะภูมิประเทศ 
 จังหวัดกาฬสินธุ์มีลักษณะภูมิประเทศเป็นภูเขาสูงจนถึงที่ราบลุ่มแม่น้ าแซ่ซัง ดังนั้น

ลักษณะภูมิประเทศโดยทั่วไปสามารถแบ่งได้เป็น 4 ลักษณะดังนี้ 
1. พ้ืนที่ที่เป็นภูเขา ได้แก่ เทือกเขาภูพานซึ่งมีระดับความสูงจากระดับน้ าทะเลปานกลาง   

200-500 เมตร อยู่ทางทิศตะวันออกและทิศเหนือของจังหวัดในพ้ืนที่ของอ าเภอสมเด็จ อ าเภอเขาวง 
อ าเภอกุฉินรายณ์ อ าเภอห้วยผึ้ง บริเวณนี้เป็นแหล่งต้นน้ าล าธารที่ส าคัญได้แก่ล าน้ าปาว ล าน้ าพาน 

2. สภาพที่เป็นหุบเขา อยู่ในเขตอ าเภอเขาวง มีลักษณะเป็นที่ราบระหว่างหุบเขาสภาพเป็น
ลูกคลื่น สูงจากระดับน้ าทะเลปานกลาง 175-250 เมตร มีลักษณะเป็นพื้นที่ลูกคลื่นลอยตื้น อยู่ในเขต
อ าเภอท่าคันโท อ าเภอสหัสขันธ์มีบริเวณทิศเหนือของอ าเภอยางตลาด ทิศใต้ของอ าเภอสมเด็จและ
บางส่วนของอ าเภอห้วยผึ้ง 

3. สภาพเป็นลูกคลื่นสูงจากระดับน้ าปานกลาง 175-250 เมตร มีลักษณะเป็นลูกคลื่นลอนตื้น 
อยู่ในเขตอ าเภอท่าคันโท อ าเภอสหัสขันธ์ บริเวณทิศเหนือของอ าเภอยางตลาด ทิศใต้ของอ าเภอ
สมเด็จและบางส่วนของอ าเภอห้วยผึ้ง 

4 สภาพค่อนข้างราบ มีระดับน้ าทะเลปานกลาง 150-170 เมตร อยู่ในบริเวณอ าเภอเมือง
ยางตลาดบางส่วนของทิศใต้ของอ าเภอสหัสขันธ์ ทางทิศตะวันออกของอ าเภอสมเด็จและอ าเภอห้วย
ผึ้ง 
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5 สภาพพ้ืนที่ราบลุ่มริมฝั่งน้ า เป็นที่ราบริมฝั่งแม่น้ าชี ล าน้ าปาว ล าน้ าพาน มีความสูงจาก
ระดับน้ าทะเลปานกลาง 140-150 เมตร อยู่ในอ าเภอกมลาไสย บางส่วนของอ าเภอเมืองและอ าเภอ
ยางตลาด 

2.1.3 สภาพทางภูมิอากาศ 
ภูมิอากาศโดยทั่วไปของจังหวัดกาฬสินธุ์ จะมีลักษณะคล้ายคลึงกับจังหวัดอ่ืน ๆ ใน 

ภาคตะวันออกเฉียงเหนือ คือ มีอากาศร้อนและค่อนข้างหนาวในฤดูหนาว ส่วนฤดูฝนจะมีฝนตกชุก
ช่วงเดือนพฤษภาคมถึงเดือนตุลาคม จังหวัดกาฬสินธุ์มีฝนตกเฉลี่ย 1398.4 มิลลิลิตร/ปี อุณหภูมิ
สูงสุด 41.5 องศาเซลเซียสและอุณหภูมิต่ าสุด 12.7 องศาเซลเซียส  )ที่มา : สถานีอุตุนิยมวิทยา
กาฬสินธุ์ข้อมูลเฉลี่ยรอบ 17 ปี( 

2.1.4 สภาพทางเศรษฐกิจ 
 โดยทั่วไปและผลิตภัณฑ์มวลรวม สภาพทางเศรษฐกิจของจังหวัดกาฬสินธุ์ ใน ปี 

2554 พบว่าประชากร ของจังหวัดมีรายได้เฉลี่ยต่อคน 42,775 บาทต่อปี รายได้ส่วนใหญ่มาจากจาก
เกษตรกร การล่าสัตว์และป่าไม้ ร้อยละ 23.37 คิดเป็นมูลค่า 10,117 ล้านบาท รองลงมาเป็น
ภาคอุตสาหกรรม ร้อยละ 119.48 คิดเป็นมูลค่า 8,432 ล้านบาท และภาคการศึกษาร้อยละ 17.07 
คิดเป็นมูลค่า 7,391 ล้านบาท ส าหรับสาขาค้าปลีกค้าส่งอยู่ล าดับที่ 4 ร้อยละ 9.12 คิดเป็นมูลค่า 
3,949 ล้านบาท 
 
2.2 การรับรู้ระยะไกล (Remote Sensing) 

รีโมทเซนซิง เป็นศาสตร์ที่เกี่ยวข้องทั้งทางด้านวิทยาศาสตร์กายภาพ ทางด้านมนุษยศาสตร์ 
และ สังคมศาสตร์ข้อมูลที่ได้จากรีโมทเซนซิงนั้นสามารถน ามาใช้ในการอธิบายการเปลี่ยนแปลงเชิง
พ้ืนได้ ส าหรับ การได้มาของข้อมูลจากรีโมทเซนซิงหลากหลายรูปแบบด้วยกัน ซึ่งในปัจจุบัน
วิวัฒนาการในการส ารวจพ้ืน โลกได้ก้าวหน้าไปมาก มีการพัฒนาเพ่ือใช้ดาวเทียมส ารวจพ้ืนโลกซึ่ง 
ครอบคลุมพ้ืนที่เป็นบริเวณกว้างและ ให้รายละเอียดในระดับสูง อีกทั้งประสิทธิภาพในการบันทึ ก 
ข้อมูลในช่วงคลื่นที่สายตามนุษย์มองไม่เห็น )ใช้ ฟิล์มธรรมดาบันทึกข้อมูลไม่ได้( เช่น ช่วงคลื่นในย่าน
อินฟราเรดใกล้  )near infrared) อินฟราเรดความร้อน )thermal infrared) และไมโครเวฟ 
)microwave) เป็นต้น จึงท าให้ได้ข้อมูลที่ยังไม่เคยทราบมาก่อนและมี ประโยชน์ในการน ามาใช้ 
วางแผนและแก้ปัญหาต่าง ๆ ได้อย่างรวดเร็ว ถูกต้อง และทันต่อเหตุการณ์มาก ยิ่งขึ้น ด้วยเหตุนี้
ข้อมูล จากดาวเทียมจึงถูกน ามาใช้อย่างแพร่หลาย ทั้งในด้านวิทยาศาสตร์กายภาพ และ ทางด้าน 
มนุษยศาสตร์ และสังคมศาสตร์ สุระ, (2554) ให้ความหมายว่า “การรับรู้จากระยะไกลเป็นการ 
ส ารวจและตรวจสอบคุณลักษณะ ของวัตถุและสิ่งต่าง ๆ โดยได้ในการสัมผัสวัตถุหรือสิ่งต่าง ๆ 
เหล่านั้น โดยตรง หรืออาจกล่าวว่าการรับรู้จากระยะไกลเป็นวิทยาศาสตร์และศิลปะของการได้มาซึ่ง
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ข้อมูลเกี่ยวกับ วัตถุพ้ืนที่หรือปรากฏการณ์ จากเครื่องมือบันทึกข้อมูลโดยปราศจากการเข้าไปสัมผัส
วัตถุเป้าหมายทั้งนี้  อาศัยคุณสมบัติของคลื่น แม่เหล็กไฟฟ้าเป็นสื่อในการได้มาของข้อมูลใน 3 
ลักษณะ คือ คลื่นรังสี รูปทรง สัณฐานของวัตถุบน พ้ืนผิวโลก และการเปลี่ยนแปลงตามช่วงเวลา” 
 

 
2.2.1 องค์ประกอบและกระบวนการของการรับรู้จ ากระยะไกล 

 

 
 

ภาพประกอบที่ 1 องค์ประกอบของการรับรู้จากระยะไกล 
 
องค์ประกอบที่ส าคัญของการรับรู้จากระยะไกล )ภาพประกอบที่ 1) ได้แก่ 
1) แหล่งก าเนิดพลังงาน เช่น ดวงอาทิตย์ 
2) วัตถุและปรากฏการณ์ต่าง ๆบนพื้นผิวโลกเช่น ป่าไม้ น้ า ถนนลาดยางและสิ่งปลูก สร้าง เป็นต้น 
3) เครื่องมือหรืออุปกรณ์ในการบันทึกข้อมูลที่ถูกติดตั้งไว้บนดาวเทียมท้ังนี้การรับรู้จากระยะไกลที่ ใช้
พลังงานจากธรรมชาติเรียกว่า “passive remote sensing” (ภาพประกอบที่ 2) 
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ภาพประกอบที่ 2 การรับรู้จากระยะไกลแบบ passive remote sensing และ active remote 
sensing 

  
ตามหลักทางฟิสิกส์ที่ว่าที่อุณหภูมิสูงกว่า 0 เคลวิน )K) หรือ )-273 องศาเซลเซียส( ทั้งนี้

สสารสามารถเปล่งรังสีแม่เหล็กไฟฟ้าออกมาได้อย่างต่อเนื่อง ส่วนเครื่องบันทึกข้อมูลที่มีแหล่ง
พลังงานที่สร้างขึ้นและส่งไปยังวัตถุเป้าหมาย เช่น ระบบเรดาร์เรียกว่า“active remote sensing”ใน
ระบบนี้ดาวเทียมหรือเครื่องบันทึกภาพจะต้องส่งคลื่นแม่เหล็กไฟฟ้าไปกระทบกับวัตถุแล้ววัดค่าที่
สะท้อนมาดังนั้นระบบนี้ตัวดาวเทียมจะต้องมีแหล่งผลิตพลังงานที่มากกว่าในระบบแรก 

2.2.2 ปฏิสัมพันธ์ของพลังงานคลื่นแม่เหล็กไฟฟ้ากับสิ่งปกคลุมผิวโลก 
เราสามารถจ าแนกวัตถุต่าง ๆ ออกจากกันได้เนื่องจากความแตกต่างกันของลักษณะ 

ปฏิสัมพันธ์ของพลังงานคลื่นแม่เหล็กไฟฟ้ากับสิ่งปกคลุมผิวโลกได้ 3 ลักษณะ คือ การสะท้อน 
พลังงาน การ ดูดซับพลังงาน และการส่งพลังงานอันเป็นปรากฏการณ์ส าคัญในการรับรู้จากระยะไกล 
ของวัตถุบน พ้ืนผิวโลกทั้ งนี้สามารถเขียนเป็นสมการความสมดุลพลังงาน )energy balance 
equation) ได้ดังสมการที่ 2.1 
 
                           ( ) ( ) ( ) ( )I R A TE E E E                                                 (2.1) 

 
โดยที่  ( )IE   คือ พลังงานตกกระทบที่ความยาวคลื่น   
        ( )RE   คือ พลังงานสะท้อนที่ความยาวคลื่น   
        ( )AE   คือ พลังงานดูดกลืนที่ความยาวคลื่น   
        ( )TE   คือ พลังงานส่งผ่านที่ความยาวคลื่น   
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 สัดส่วนของการดูดกลืนการส่งผ่านการสะท้อน พลังงานแตกต่างกันตามชนิดของสสารท าให้
สามารถแยกชนิดของวัตถุในภาพถ่ายได้นอกจากนี้วัตถุเดียวกันสัดส่วนของการเกิดปฏิสัมพันธ์ทั้ง สาม
นี้แตกต่างกันตามความยาวของช่วงคลื่นที่ตกกระทบอีกด้วยวัตถุสองชนิดนี้อาจไม่แตกต่างกัน ในช่ว ง
คลื่นหนึ่งแต่สามารถแยกจากกันได้ในอีกช่วงคลื่นหนึ่ง ในช่วงคลื่นสายตามองเห็นความแตกต่างกัน
ทางด้านเชิงคลื่นรังสีของวัตถุจะแสดงให้เห็นรูปแบบของสีต่าง ๆ เช่น การที่เรามองเห็นวัตถุเป็นสี
เขียวเนื่องจากวัตถุสะท้อนพลังงานในช่วงคลื่นสีเขียวมากเนื่องจากระบบบันทึกพลั งงานส่วนใหญ่
บันทึกพลังงานสะท้อน ดังนั้นการศึกษาเพ่ือแยกชนิดของวัตถุจึงเป็นการศึกษาการสะท้อนพลังงาน
ของวัตถุทั้งนี้สามารถเขียนเป็น สมการได้ดังสมการที่ 2.2 และแสดงได้ดัง )ภาพประกอบ ที่ 2.3) 
                                     ( ) ( ) [ ( ) ( )]A I A TE E E E                                              (2.2) 
พลังงานสะท้อนมีค่าเท่ากับพลังงานตกกระทบวัตถุลบด้วยผลรวมของพลังงานดูดกลืนกับ พลังงาน
ส่งผ่าน 

 
ภาพประกอบที่ 3 ปฏิสัมพันธ์ของพลังงานคลื่นแม่เหล็กไฟฟ้ากับผิวโลก 

 
ลักษณะพ้ืนผิวหน้าของวัตถุเป็นสิ่งส าคัญที่มีอิทธิพลต่อการสะท้อนพลังงาน )ภาพประกอบที่ 

4( วัตถุที่มีพ้ืนหน้าเรียบมุมสะท้อนพลังงานจะเท่ากับมุมตกระทบเป็นลักษณะการสะท้อนแสงตรง 
)specular reflectors) ส่วนวัตถุที่มีผิวหน้าขรุขระการสะท้อนพลังงานจะไม่เป็นระเบียบ เรียกว่า 
การสะท้อนแสงแพร่ )diffuse reflection) อย่างไรก็ตามวัตถุส่วนใหญ่มีลักษณะผสมผสานกัน
ระหว่างสองลักษณะนี้ )ภาพประกอบที่ 5( 
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ภาพประกอบที่ 4 Spectral signature 

 
 

 
ภาพประกอบที่ 5 ลักษณะพ้ืนผิวหน้าของวัตถุที่มีอิทธิพลต่อการสะท้อนพลังงาน 

 
นอกจากลักษณะของพ้ืนผิววัตถุแล้วยังต้องค านึงถึงความยาวของช่วงคลื่นที่ตกกระทบวัตถุ

ด้วยถ้า เป็นพลังงานช่วงคลื่นสั้นเมื่อเปรียบเทียบกับขนาดอนุภาคของวัตถุ หรือความต่างระดับของ
ผิวหน้าวัตถุ การ สะท้อนแสงอาจเป็นแบบให้ลักษณะวัตถุพ้ืนผิวขรุขระได้ แต่ถ้าในวัตถุชนิดเดียวกันนี้
ได้รับพลังงานตก กระทบในช่วงคลื่นยาว เมื่อเปรียบเทียบกับผิววัตถุ การสะท้อนแสงอาจเป็นแบบ
ลักษณะของวัตถุที่มีพ้ืนผิว ราบได้ ในการรับรู้จากระยะไกลเป็นการวัดสัดส่วนในการสะท้อนพลังงาน
ของวัตถุบนผิ วโลก ณ ช่วงคลื่น ใด ช่วงคลื่นหนึ่ ง คือ การสะท้อนเชิงสเปกตรัม ) spectral 
reflectance) ซึ่งหาได้จากสมการที่ 2.3 

 

                                           
( )

( )I

E

E








                                                       (2.3) 

โดยที่    = ความสะท้อนเชิงสเปกตรัมท่ีช่วงคลื่น   
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ดังนั้นพลังงานที่วัดได้โดยเครื่องรับรู้จึงประกอบด้วยพลังงานที่สะท้อน หรือแผ่จากพ้ืนผิววัตถุ
พลังงานบางส่วนจากปฏิสัมพันธ์ในชั้นบรรยากาศ พลังงานที่สะท้อนกลับโดยตรงจากก้อนเมฆ ค่าที่วัด
ได้นี้จะน้อยหรือมากหรือเปลี่ยนแปลงไปขึ้นอยู่กับสภาวะของบรรยากาศ มุมของดวงอาทิตย์ต าแหน่ง
ของเครื่องรับรู้คุณสมบัติของวัตถุในการสะท้อน การดูดกลืน และการส่งผ่านพลังงาน เป็นต้น 
 
2.3 อุณหภูมิพื้นผิว 

อุณหภูมิพ้ืนผิว )Land Surface Temperature, LST) เป็นการศึกษาความร้อนพ้ืนผิวของ
โลกซึ่งจะ รับรู้ได้เมื่อสัมผัสสถานที่นั้น ๆ โดยที่มุมมองบนดาวเทียมพ้ืนผิวของโลกนั้นจะต้องมองผ่าน
ชั้นบรรยากาศลง ไปยังพ้ืนที่ ซึ่งอาจเป็นหลังคาของอาคาร เรือนยอดของต้นไม้ น้ าแข็ง หรือหิมะ 
ดังนั้นอุณหภูมิพ้ืนผิวจึงไม่ได้ เหมือนกับอุณหภูมิในอากาศ ส่วนใหญ่จะมีการน้ าอุณหภูมิพ้ืนผิวไปใช้
ประโยชน์เพ่ือศึกษาการเปลี่ยนแปลง สภาพอากาศของโลก เนื่องจากมีความร้อนที่เพ่ิมมากขึ้น ศึกษา
รูปแบบของสภาพภูมิอากาศ โดยตรวจสอบ การเพ่ิมขึ้นของก๊าซเรือนกระจกในชั้นบรรยากาศที่มี ผล
ต่ออุณหภูมิพ้ืนผิวการเพ่ิมขึ้นของอุณหภูมิพ้ืนผิวที่ ส่งผลกระทบต่อธารน้ าแข็ง แผ่นน้ าแข็ง และพืช
พรรณในระบบนิเวศของโลก อีกทั้งยังมีงานวิจัยที่น้ า อุณหภูมิพ้ืนผิว พร้อมกับช่วงคลื่นอินฟราเรด
ความร้อนมาใช้ศึกษาการเกิดปรากฏการณ์โดมความร้อนของ เมือง การตรวจวัดพ้ืนที่เกิดไฟป่า การ
ตรวจหาพ้ืนที่ระบาดของเพลี้ยแป้งในมันส าปะหลัง ด้วยวิธีการ ค านวณอุณหภูมิพ้ืนผิวที่แตกต่างกัน 
โดยปัจจุบันในงานวิชาการได้ให้ความส าคัญเกี่ยวกับเรื่องอุณหภูมิ พื้นผิวเป็นจ้านวนมาก และให้ความ
สนใจในการพัฒนาหลักการวัดอุณหภูมิพ้ืนผิวจากอวกาศด้วย 

 
 

2.4 สมการที่ใช้ในการหาค่าดัชนี 
 2.4.1 ดัชนีผลต่างพืชพรรณแบบมาตรฐาน (Normalized Difference Vegetation Index : 
NDVI) 

การประมาณค่าดัชนีพืชพรรณ NDVI โดยน าผลลัพธ์ค่าการสะท้อนรังสีที่ปรับแก้ด้วยมุมความ
สูงของดวงอาทิตย์จากสูตรการค านวณที่ 2.2 และ 2.3 พร้อมค่าคงที่ของพารามิเตอร์ที่ใช้ในการ
ค านวณ มาประมวลผลหาค่าดัชนีพืชพรรณในสูตรการค านวณที่ 2.4 โดยค่าท่ีได้จะอยู่ในช่วง ระหว่าง 
-1 ถึง 1 ดังนี้ 
                                                                    

                                       
NIR RED

NDVI
NIR RED





                                            (2.4) 

โดยที่  NDVI  คือ ค่าดัชนีผลต่างพืชพรรณแบบมารตราฐาน 
        NIR  คือ ค่าสะท้อนพลังงานในช่วงคลื่นอินฟราเรดใกล้ )Near Infrared Band) 
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          RED  คือ ค่าสะท้อนพลังงานในช่วงคลื่นสีแดง )RED Band) 
 ทั้งนี้ค่าของ NDVI  จะอยู่ในช่วง -1 ถึง +1 
- บริเวณท่ีมีค่า NDVI  อยู่ในช่วงค่าลบพ้ืนที่จะเป็นพ้ืนที่น้ า 
- บริเวณท่ีมีค่า NDVI  เข้าใกล้ค่า 0 แสดงถึงพ้ืนที่ที่มีพืชพรรณสีเขียวน้อย 
- บริเวณท่ีมีค่า NDVI  เข้าใกล้ค่า +1 แสดงถึงพ้ืนที่ที่มีพืชพรรณสีเขียวปกคลุมมาก 

2.4.2 การประมาณค่าสัดส่วนของพืชพรรณที่ปกคลุมดิน (Fractional Vegetation Cover : 
FVC)       

สัดส่วนของพืชพรรณที่ปกคลุมสามารถค านวณจากปริมาณสัดส่วนของพืชพรรณใน แต่ละ
พิกเซลโดยในแต่ละพิกเซลจะประกอบไปด้วยองค์ประกอบ 2 ประเภท คือ มีพืชพรรณปกคลุม และไม่
มีพืชพรรณปกคลุม ทั้งนี้ความแม่นย าจะขึ้นอยู่กับแต่ละพิกเซลมีการผสมของสิ่งปกคลุมดิน มากน้อย
แค่ไหน และสามารถค านวณได้จากสมการ (2.5) 

                                      s

v s

NDVI NDVI
FVC

NDVI NDVI





                                 (2.5) 

โดยที่  sNDVI  คือ ค่า NDVI  ของดิน 
        vNDVI  คือ ค่า NDVI  ของพืชพรรณ 

 2.4.3 การประมาณค่าอุณหภูมิพ้ืนผิว  (land surface emissivity :LSE) 
จากค่า FVC ด้วยสูตรการค านวณที่ )2.6( และค่าคงที่ของพารามิเตอร์ที่ใช้ในการค านวณดัง 

ตารางที่ 1 ดังนี้ 
                                  *(1 FVC) *s vLST FVC                                      (2.6)     
 โดยที่  s  คือ การแผ่รังสีของดิน 
        v  คือ การแผ่รังสีของพืช 

ตารางท่ี 1 ค่าการเปล่งรังสี )emissivity) ของ ช่วงคลื่นอินฟราเรดความร้อนแบนด์ 10 และ 11 
Emissivity แบนด์ 10 แบนด์ 11 

s  0.971 0.977 

v  0.987 0.989 
 2.4.4 การประมาณค่าเฉลี่ยและค่าผลต่างของ LSE ด้วยสูตรการค านวณ ที่ 2.7 และ 2.8 
ดังนี้ 
 

                                   10 11

2

LST LST
m


                                                   (2.7) 

                            10 11m LST LST                                               (2.8) 
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2.4.5 การประมาณค่าการแผ่รังสีเชิงคลื่น (TOA spectral radiance) 
โดยใช้ข้อมูลจากดาวเทียม LANDSAT 8 ระบบ TIRS แบนด์ 10-11 มาแปลงค่าจาก

ตัวเลข 
ดิจิตอล )digital number) เป็นค่าการแผ่รังสีเชิงคลื่นด้วยสูตรการค านวณที่ 2.9 และค่าคงที่ ของ
พารามิเตอร์ที่ใช้ในการค านวณ ดังตารางที่ 2 ดังนี้ 
                                            cal LL M Q A                                                     (2.9)           
 โดยที่  L  คือ ค่าการแผ่รังสีเชิงคลื่น )TOA spectral radiance) มีหน่วยเป็น )Watts 

/(m2*srad*μm) 
        M   คือ ค่าการคูณส าหรับการแปลงค่าเฉพาะแบนด์นั้นจากข้อมูลที่ให้มา 
)RADIANCE_MULT_BAND_X, โดย X คือ จ านวนแบนด์( 
      calQ   คือ ค่าการเพ่ิมส าหรับการแปลงค่าเฉพาะแบนด์นั้นจากข้อมูลที่ให้มา 
(RADIANCE_ADD_BAND_X, โดย X คือ จ านวนแบนด์ 
       LA   คือ ค่าการวัดและการนับจ านวนขนาด ภาพ )DN) 
ตารางท่ี 2 ค่าคงท่ี metadata ส าหรับข้อมูลจากดาวเทียม LANDSAT8 แบนด์ 10 - 11 (ช่วงคลื่น
อินฟราเรด ความร้อน) 

 
แบนด์ 

 

Radiance  
K1 

 
K2 Mult_band Add_band 

10 0.0003342 0.1 774.89 1321.08 
11 0.0003342 0.1 480.89 1201.14 

 
 2.4.6 การประมาณค่าอุณหภูมิสัมบูรณ์ (brightness temperature) จากค่าการแผ่รังสีเชิง 
คลื่นด้วยสูตรการค านวณที่ 2.10 และค่าคงที่ของพารามิเตอร์ที่ใช้ในการค านวณ ดังตารางที่ 2 ดังนี้ 

                                        2

1

273

( 1)

K
TB

K
In

L

 



                                         (2.10) 

โดยที่  TB  คือ ค่าอุณหภูมิสัมบูรณ์จากการแผ่รังสีเชิง คลื่น โดยปกติแล้วจะมีหน่วยเป็นเคลวิน แต่
เนื่องจากในสมการมีการแปลงหน่วยแล้ว จึงท าให้มีหน่วยเป็นองศาเซลเซียส ( C ) 

L   คือ ค่าการแผ่รังสีเชิงคลื่น )TOA spectral radiance) มีหน่วยเป็น )Watts /(m2*srad*μm) 

1K   คือ ค่าคงที่ในการแปลงของแบรนด์ความร้อนจากข้อมูลที่ให้มา)K1_CONSTANT_BAND_x, โดย
x คือแบนด์ 10 หรือ 11) 
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2K  คือ ค่าคงที่ในการแปลงของแบรนด์ความร้อนจากข้อมูลที่ให้มา )K2_CONSTANT_BAND_x,โดย 
x คือแบนด์ 10 หรือ 11) 
  

 2.4.7 การประมาณค่าอุณหภูมิพ้ืนผิว (Land Surface Temperature: LST) 
 จากค่าค านวณ ที่ได้จากข้อ 1-6 น ามาเข้าสูตรการค านวณที่ 2.11 พร้อมกับค่าคงที่ของ
พารามิเตอร์ที่ใช้ในการค านวณ 

2

10 1 10 11 2 10 11 0 3 4 5 6( ) ( ) ( )(1 ) ( ) mLST TB C TB TB C TB TB C C C W m C C W           

 (2.11) 
โดยที่  10TB , 11TB   คือ อุณหภูมิสัมบูรณ์ )brightness temperature) ของแบรนด์ 10 และ 11 
        0C  ถึง  6C     คือ ค่าคงท่ีส าหรับหลักการ split-window 
      W  คือ ค่าคงท่ีไอน้าในชั้นบรรยากาศ )atmospheric water-vapour content :0.013) 
       m    คือ ค่าเฉลี่ยของ LSE 
        m   คือ ผลต่างของค่า LSE 
    LSE  คือ ค่า Land Surface Emissivity 
ตารางท่ี 3 ค่าคงท่ีส าหรับสูตรการค านวณอุณหภูมิพ้ืนผิวหลักการ split-window 

ค่าคงที่ ค่าของค่าคงท่ี 

  0C  -0.268  

  1C  1.378  

  2C  0.183 

  3C  54.300 

  4C  -2.238 

  5C  -129.20 

  6C  16.40 
 
2.5 ดาวเทียม Landsat 8 OLI และ Thermal Infrared Sensor (TIRS) 

Landsat 8 เป็นดาวเทียมส ารวจทรัพยากรธรรมชาติของประเทศสหรัฐอเมริกา ได้รับการ
พั ฒ น า โ ด ย ค ว า ม ร่ ว ม มื อ ร ะ ห ว่ า ง อ ง ค์ ก ร  National Aeronautics and Space 
Administration(NASA) และUnited States Geological Survey (USGS) ถูกส่งขึ้นสู่วงโคจรวันที่ 
11 กุมภาพันธ์ พ.ศ. 2556 และเริ่มปฏิบัติการวันที่ 30 พฤษภาคม พ.ศ. 2556 (ศูนย์ปฏิบัติการภูมิ
สารสนเทศส านักบริหารพ้ืนที่อนุรักษ์ที่ 9 (อุบลราชธานี(, 2557) ดาวเทียม Landsat 8 มีวงโคจรแบบ
สัมพันธ์กับดวงอาทิตย์ที่ความสูงประมาณ438 ไมล์หรือ 705 กิโลเมตร โดยจะโคจรซ้ าต าแหน่งเดิมทุก 
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16 วัน ความกว้างของแนวถ่ายภาพ 185 กิโลเมตร ประกอบด้วยระบบบันทึกภาพ 2 ชนิด คือ OLI มี
ทั้งหมด 11 ช่วงคลื่นดังตารางที่ 4 
ตารางท่ี 4 อุปกรณ์บันทึกข้อมูลดาวเทียม Landsat 8 และ Thermal Infrared Sensor (TIRS) 

 
แบรนด์ ความยาวคลื่น(ไมโครเมตร) รายละเอียดภาพ 

Resolution(เมตร) 
1 0.43 – 0.45 (Coastal Aerosol) 30 
2 0.45 – 0.51 (Blue) 30 
3 0.53 – 0.59 (Green) 30 
4 0.64 – 0.67 (Red) 30 
5 0.85 – 0.88 (Near Infrared – NIR) 30 
6 1.57 – 1.65 (SWIR 1) 30 
7 2.11 – 2.29 (SWIR 2) 30 
8 0.50 – 0.68 (Panchromatic) 15 
9 1.36 – 1.38 (Cirrus) 30 
10 10.60 – 11.19 (Thermal Infrared 

– TIRS 1) 
100 

11 11.50 – 12.51 (Thermal Infrared 
– TIRS 2) 

100 

 
2.6 การจ าแนกประเภทข้อมูลจากภาพถ่ายดาวเทียม (Image Classification) 
 เป็นการตรวจสอบวิเคราะห์ และแบ่งแยกข้อมูล ที่มีคุณสมบัติการดูดกลืนช่วงคลื่นแสง
เหมือนกัน ให้อยู่ในกลุ่มเดียวกัน )Class) และแบ่งแยกข้อมูล ที่มีคุณสมบัติการดูดกลืนช่วงคลื่นแสง
ต่างกัน ออกเป็นกลุ่มๆ โดยมีวิธีการจ าแนกประเภทข้อมูล ออกเป็น 2 วิธีการหลักคือ 

1. การจ าแนกข้อมูลแบบควบคุม )Supervised Classification) เป็นวิธีการจ าแนกข้อมูลที่ต้อง 
อาศัย สีของข้อมูลตัวอย่าง เพ่ือน ามาใช้เป็นตัวแทนของข้อมูลในภาพถ่ายฯ ที่แสดงสีเหมือนกัน อาทิ 
การก าหนดให้สีของนาข้าวสีเหลืองอ่อน เป็นตัวแทนของนาข้าวในฤดูเก็บเกี่ยวทั้งหมด หรือการ
ก าหนดให้สี น้ าเงิน เป็นตัวแทนของพ้ืนผิวที่เป็นน้ าทั้งหมด 

2. การจ าแนกประเภทข้อมูลแบบไม่ควบคุม   )Unsupervised Classification) เป็นวิธีการจ า- 
แนกข้อมูล โดยให้ข้อมูลแสดงเฉดสีได้อย่างอิสระ )อัตโนมัติ( โดยที่ผู้ท าการวิเคราะห์ก าหนดจ านวน
ชั้นข้อมูลเพื่อให้ภาพถ่ายหลังการท าการจ าแนกด้วยวิธีดังกล่าว แสดงจ านวนสีตามท่ีได้ก าหนด 
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2.7 วิจัยท่ีเกี่ยวข้อง 
 วลดา เดชะพงศ์ธนา และคณะ )2557) ได้ศึกษาการใช้ประโยชน์ที่ดิน หาค่าอุณหภูมิพ้ืนผิว
ของการ ใช้ประโยชน์ที่ดินบริเวณอ าเภอบางน้ าเปรี้ยว จังหวัดฉะเชิงเทรา ด้วยข้อมูลจากดาวเทียม 
LANDSAT 8 วันที่ 17 พฤศจิกายน 2557 ซึ่งมีจ านวน 11 แบนด์ ประกอบด้วยระบบ OLI และ TIRS 
ได้ผ่านการปรับแก้ เชิงเรขาคณิตแล้วน าข้อมูลระบบ OLI แบนด์ที่ 1-7 มาจ าแนกพ้ืนที่การใช้
ประโยชน์ที่ดิน ซึ่งประกอบด้วย พื้นที่ 4 ประเภท พบว่ามีพ้ืนที่นาข้าว 200,594.44 ไร่ พื้นที่แหล่งน้ า 
2,595.52 ไร่ พ้ืนที่ชุมชนเมือง 47,283.2 ไร่ และพ้ืนที่ไม้ยืนต้น 68,286.84 ไร่ จากการตรวจสอบ
ความถูกต้องของข้อมูล มีค่าความถูกต้อง ทั้งหมด 84 % และน าข้อมูลระบบ OLI แบนด์ที่ 4-5 พร้อม
กับข้อมูลระบบ TIRS แบนด์ที่ 10-11 มาหาค่า ดัชนีพืชพรรณ ค่า Fractional Vegetation Cover 
(FVC) ค่า Land Surface Emissivity (LSE) ค่าอุณหภูมิ สัมบูรณ์ )TB) แล้วน้ าเข้าสู่หลักการค านวณ
ของ split-window พบว่าค่าอุณหภูมิพ้ืนผิวของพ้ืนที่ชุมชนเมืองมีค่าอุณหภูมิพ้ืนผิวเฉลี่ยสูงที่สุ ด
เท่ากับ 35.55 องศาเซลเซียส รองลงมาคือพ้ืนที่ไม้ยืนต้น พ้ืนที่แหล่งน้ าและพ้ืนที่นาข้าว มีค่าอุณหภูมิ
พ้ืนผิวเฉลี่ย 32.65, 32.46 และ 32.01 องศาเซลเซียส ตามล าดับ 
 Teerawong Laosuwan (2017) ได้น าเสนอเทคนิคในการวิเคราะห์อุณหภูมิพ้ืนผิวของดิน
ด้วย ข้อมูลจากกล้องถ่ายภาพปฏิบัติการ Landsat-8 (OLI) / เซ็นเซอร์อินฟราเรดความร้อน )TIR) ใน
อ าเภอเมืองมหาสารคามจังหวัดมหาสารคามภาคตะวันออกเฉียงเหนือ การวิจัยได้ด าเนินการ
ดังต่อไปนี้สามขั้นตอน: 1). การรวบรวมข้อมูลดาวเทียมในแถบอินฟราเรดความร้อนจากดาวเทียม 
Landsat-8 TIR เพ่ื อปรับ ค่ าของ Top of Atmosphere (TOA) Reflectance จากนั้ นท าการ
วิเคราะห์อุณหภูมิพ้ืนผิวของ แผ่นดิน 2).การรวบรวมหลายวง ข้อมูลจากดาวเทียม Landsat-8 OLI 
เพ่ือปรับค่า Top of Atmosphere (TOA) Reflectance จากนั้นท าการวิเคราะห์ค่าดัชนีพืชพรรณ
ปกติ )NDVI), พืชพรรณเศษส่วน )FVC) และพ้ืนผิวของแผ่นดิน )LSE) 3).การน าผลลัพธ์ จาก 1) และ 
2) เพ่ือวิเคราะห์อุณหภูมิพ้ืนผิวของดินด้วย อัลกอริทึมแบบแยกหน้าต่าง ผลการวิจัยพบว่าการ
วิเคราะห์ข้อมูลจากดาวเทียม Landsat-8 OLI / TIR ใน วันที่ 18 มีนาคม พ.ศ. 2558 แสดงอุณหภูมิ
เฉลี่ย 33.57 ° C 
 Rajeshwari, A. and Mani, ND (2014) ได้ศึกษาการประมาณค่าอุณหภูมิพ้ืนผิวดินต าบล
ดินดิกูล จากข้อมูลจากดาวเทียม LANDSAT-8 ระบบ OLI และเลือกใช้วิธี Split-Window ในการ
ประมาณค่าอุณหภูมิพ้ืนผิวดิน โดยใช้ช่วงคลื่นอินฟราเรดความร้อน ได้แก่ แบนด์ 10 (10.60 - 11.19
ไมโครเมตร( แบนด์ 11 (11.50 - 12.51 ไมโครเมตร( และได้ใช้เกณฑ์ของดัชนีพืชพรรณ NDVI มา
ช่วยในความแม่นย าของการ ประมาณค่า ผลการศึกษาพบว่า ค่าอุณหภูมิพ้ืนผิวดินมีค่าความแตกต่าง
อยู่ระหว่าง 305 ถึง 324 เคลวิล ค่า อุณหภูมิพ้ืนผิวดินที่มากกว่า 324 เคลวิล พบมากในพ้ืนที่แห้ง
แล้งและพ้ืนที่ว่างเปล่า ค่าอุณหภูมิพ้ืนผิวดินอยู่ ระหว่าง 313-318 เคลวิล พบในพ้ืนที่ที่มีการ
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เพาะปลูกพืชส่วนค่าอุณหภูมิพ้ืนผิวดินที่มีค่าต่ ากว่า 105 เคลวิล พบในพ้ืนที่ที่มีพืชขึ้นปกคลุม
หนาแน่น 
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บทที่ 3 

วิธีการด าเนินงานการศึกษา 
การศึกษาวิจัยครั้งนี้เป็นการประมาณค่าอุณหภูมิพ้ืนผิวดินของเทศบาลกาฬสินธุ์ จากข้อมูล

ดาวเทียม LANDSAT- 8 เพ่ือศึกษาอุณหภูมิพ้ืนผิวดิน การใช้ประโยชน์ที่ดิน ความสัมพันธ์ระหว่าง
อุณหภูมิพ้ืนผิวดินกับการใช้ประโยชน์ที่ดิน และยังศึกเพ่ือท าการเกษตรในสถานที่นั้น โดยใช  ้ข้อมูล
จากดาวเทียม LANDSAT- 8 ในระบบ OLI และ TIRS ส าหรับวิธีการด าเนินงานในภาพรวมสามารถ
แสดงได้ดังภาพประกอบที่ 6 ดังนี้ 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

ภาพประกอบที่ 6 แผนการด าเนินงาน 

LST (Split Window Algorithm) 

LANDSAT 8 

Geometric Correction 

OLI band 5,4 

OLI band 4,5 

TIRS band 10,11 
Layer stack of OLI 

band 1-7 

NDVI 

  

EM

FVC 

LSE1

0 

LSE1

1 

Mean & Difference of LST 

 

EM

 

EM

Supervised 

Classification 

Accuracy Assessment 

OLI band 4,5 
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3.1 การรวบรวมข้อมูลจากดาวเทียม LANDSAT 8 

การวิเคราะห์ข้อมูลของอุณหภูมิพ้ืนผิวและข้อมูลทางอุตุนิยมวิทยาในครั้งนี้ได้ใช้ข้อมูลใน
การศึกษาดังนี้ 

3.1.1 ข้อมูลจากดาวเทียม LANDSAT 8  
ดาวเทียม Landsat 8 ขึ้นสู่วงโคจรจากฐานปล่อยจรวด Vandenberg Air Force 

รัฐแคลิฟอร์เนีย เมื่อวันที่ 11 กุมภาพันธ์ 2556 เริ่มปฏิบัติการวันที่ 30 พฤษภาคม 2556 ภายใต้การ
บริหารจัดการของ USGS โคจรสูงเหนือพ้ืนโลก 705 กิโลเมตร โดยจะสามารถใช้ข้อมูลจากดาวเทียม
ได้นานถึง 40 ปี ย้อนหลังมาช่วยในด้านสิ่งแวดล้อมอย่างต่อเนื่องต่อไป โดยข้อมูลจากดาวเทียม 
Landsat 8 มีล าดับของช่วงคลื่น (Band) จะแตกต่างจากดาวเทียม Landsat ดวงอ่ืน โดยท าการ
เลือกใช้ข้อมูลจากดาวเทียม ในปี พ .ศ . 2556 ถึงปี พ .ศ.256 2    

3.1.2 การดาวน์โหลดข้อมูลจากดาวเทียม  
ส าหรับการดาวน์โหลดข้อมูลดาวเทียมผู้ศึกษาได้ท าการดาวน์โหลดข้อมูล จากเว็ป

ไซต์ https://earthexplorer.usgs.gov/ โดยท าการดาวน์โหลดข้อมูลดาวเทียมใน พ .ศ . 2556 ถึง 
พ .ศ.2562  

3.1.3 ขั้นตอนการดาวน์โหลดข้อมูลจากดาวเทียม  
1) เข้าใช้บริการเว็ปไซต์ที่สามารถให้ข้อมูลจากดาวเทียมได้ ไปที่เว็ปไซต์ https://earthexplorer.usgs.gov/  

 
 

ภาพประกอบที่ 7 ภาพแสดงหน้าเว็ปไซด์ Earth Explorer 
 
 
 

https://earthexplorer.usgs.gov/
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2) ท าการเลือกพ้ืนที่หรือต าแหน่งที่ต้องการดาวน์โหลดข้อมูลจากดาวเทียมในช่องภาพประกอบ 8 
 

 
ภาพประกอบที่ 8 ใส่ข้อมูลของพ้ืนที่ 

3) ท าการเลือกข้อมูลจากดาวน์เทียมที่ต้องการดาวน์โหลดดังภาพ 

 
 

ภาพประกอบที่ 9 เลือกข้อมูลที่เราต้องการดาวน์โหลด 
 

 
 
4) ดาวน์โหลดข้อมูลของพ้ืนที่ที่เราเลือกไว้ดังภาพ 

ใสช่ื่อจงัหวดั กาฬสนิธุ ์

เลือกวนัเดือนปีท่ีเราตอ้งการ 

กด Data Sets 

เลือกขอ้มลูท่ีตอ้งการ

ดาวนโ์หลด 

คลกิ Results 
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ภาพประกอบที่ 10 เช็คพ้ืนที่อยู่ในที่เราต้องการ 
 

 
 

ภาพประกอบที่ 11 ดาวน์โหลดไฟล์แผนที่ 
5) แสดงภาพประกอบไฟล์ที่ดาวโหลดได้ 

คลกิปุ่ มเพ่ือดาวน์

โหลดแผนท่ี 

เช็คขอ้มลูอยู่ในพืน้ท่ี

หรือไม่ 

เลือกดาวนโ์หลดไฟล ์GEOTIFF 
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ภาพประกอบที่ 12 แสดงตัวอย่างไฟล์ดาวน์โหลดที่ได้รับ 
 

 
 

3.2 ปรับแก้ไขข้อมูลเป็นค่าดัชนีพืชพรรณ )NDVI( ในโปรแกรม ENVI 5.2 

 
 

ภาพประกอบที่ 13 แสดงหน้าต่างโปรแกรมที่ใช้ในการศึกษา 
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3.2.1 เปิดโปรแกรม ENVI 5.2 ขั้นตอนการหาค่าประมาณดัชนีพืชพรรณ (NDVI)คลิกท่ี File 
> Open As > Landsat > GeoTiff > เลือกข้อมูลดาวน์เทียมที่ดาวน์โหลดมา > OK ดังภาพ 

 
 

ภาพประกอบที่ 14 แสดงวิธีการเลือกภาพ 
 

 
3.2.1.1 พิมพ์ในช่อง  Toolbox > Radiometric Calibration > เลือก Multispectral > OK > 
เลือกที่เก็บ > OK 

 
 

ภาพประกอบที่ 15 ขั้นตอนการท า Radiometric Calibration 
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3.2.1.2 พิมพ์ในช่อง Toolbox > Dark Subtraction > เลอืก Radio > OK > Choose > OK 

 
 

ภาพประกอบที่ 16 ขั้นตอนการท า Dark Subtraction 
 
 

3.2.1.3 พิมพ์ในช่อง Toolbox > Band Math > ใส่สมการของ TOA > Add to list > OK > Map 
Variable to Input File > Dark > OK > Choose > OK 

 
 

ภาพประกอบที่ 17 ขั้นตอนการท า TOA 
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3.2.1.4 พิมพ์ในช่อง Toolbox > Band Math > ใส่สมการของ NDVI > Add to list > OK > 
B4=RED,B5=NIR > Choose > OK 

 
 

ภาพประกอบที่ 18 ขั้นตอนการท า NDVI 
 

 
3.2.1.5 พิมพ์ในช่อง Toolbox > Compute Statistics > NDVI > Stats Subset > Image > 
ครอบรูป > OK > OK > OK 

 
 

ภาพประกอบที่ 19 ขั้นตอนการหาค่า Max, Min, Mean 
 

(B5-B4/B5+B4) 
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3.2.2 ขั้นตอนการท าการประมาณค่าอุณหภูมิพ้ืนผิว (Land Surface Temperature: LST) 

พิมพ์ในช่อง Toolbox > Band Math > ใส่สมการ LST > OK 

 
 

ภาพประกอบที่ 20 ขั้นตอนการท า LST 
 

3.2.2.1 ท าการเปลี่ยนโซน Open File > Toolbox > Reproject Raster > Browse > LST > OK 
>Select Coordinate System > Projected Coordinate System > UTM > WGS 1972 
>Northem Hemisphere > WGS 1972 UTM Zone 47N > OK > เลือกที่เก็บ > OK 

 
 

ภาพประกอบที่ 21 ขั้นตอนการเปลี่ยนZone 48N เป็น Zone 47N 
 

B 1+1.378(* B 1- B 2) + 0.183(* B 1- B 2) ^ 2 + (-0.268(+)54.300 +
                    (-2.238*)0.0013(*)1- B 3((+)-

129.20+)16.40*0.0013*) B4 
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3.2.3 ขั้นตอนการจ าแนกข้อมูล (Classification) 
3.2.3.1 File > Open As > Landsat > Geo Tiff With Metadata > OK > คลิกขวา > Change 
RGB Bands > สีแดง=NIR, สีเขียว=RED, สีน้ าเงิน=GREEN > OK  

 
 

ภาพประกอบที่ 22 ขั้นตอนการจ าแนกสี 
 

3.2.3.2 พิมพ์ในช่อง Toolbox > Classification Workflow > Next > Use Training Data > 
Next  

 
 

ภาพประกอบที่ 23 ขั้นตอนการจ าแนกพ้ืนที่ 
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3.3 การตัดภาพข้อมูล  
 3.3.1 เปิดไฟล์แผนที่จังหวัด > เปิดไฟล์เทศบาล > Vector to ROI > คลิกไฟล์จังหวัด > OK 
> OK 

 
 

ภาพประกอบที่ 24 ขั้นตอนการท า Vector to ROI 
 
 

3.3.2 พิมพ์ในช่อง Toolbox > Subset Data From ROIs > เลือกไฟล์แรก > OK > EVF : 
municipal > Yes > Choose > OK  

 
 

ภาพประกอบที่ 25 ขั้นตอนการตัดแผนที่เทศบาลกาฬสินธุ์ 
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3.3.3 ได้แผนที่เทศบาลกาฬสินธุ์ จ .กาฬสินธุ์  

 
 

ภาพประกอบที่ 26 ภาพแผนที่เทศบาลกาฬสินธุ์ 
 

 
3.4 การหาพื้นที่จากโปรแกรม ArcGIS 10.5 

 
 

ภาพประกอบที่ 27 แสดงหน้าต่างโปรแกรมที่ใช้ในการศึกษา 
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3.4.1 Add data > เลือกไฟล์ที่เราตัดมาจาก 3.3.3 > Add  

 
 

ภาพประกอบที่ 28 การเปิดใช้งานจากโปรแกรม ENVI 
 

 3.4.2 คลิกขวา > Properties > Labels > OK > คลิกขวา > Label Features   

 
 

ภาพประกอบที่ 29 การแสดงชื่อของแต่ละพ้ืนที่ 
 
 

คลกิเพ่ือแสดงช่ือ

ของแต่ละพืน้ที ่

คลกิ 
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3.4. 3 Arc Toolbox > Data Management Tools > Generalization > Dissolve > ลากไฟล์มา
ที่ Input Featurest > OK > คลิกขวา > Properties > Label Features 

 
 

ภาพประกอบที่ 30 ขั้นตอนการท า Dissolve หรือการรวมข้อมูลชุดเดียวกัน 
 

 
3.4.4 คลิกขวา > Properties > Symbology > Categories >Add All Values > เลือก

ประเภทสี > OK 

 
 

ภาพประกอบที่ 31 การจ าแนกพ้ืนที่โดยการใส่สี 
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บทที่ 4 
ผลการด าเนินงาน 

ผลการวิเคราะห์จากกระบวนการจ าแนกประเภทข้อมูลจากดาวเทียม จัดกลุ่มชั้นของข้อมูล
โดยใช้เทคนิคการจ าแนกข้อมูลแบบก ากับดูแล (Supervised Classification) โดยจ าแนกแบบความ
น่าจะเป็นสูงสุด (Maximum Likelihood Classification) และการค านวณ อุณหภูมิ พ้ืนผิว มี
ดังต่อไปนี้ 

4.1 ผลการจ าแนกประเภทข้อมูลการใช้ประโยชน์ที่ดินของเทศบาลเมืองกาฬสินธุ์พ .ศ . 2556 ถึงปี 
พ .ศ . 2562  

ผู้ศึกษาได้จัดกลุ่มชั้นข้อมูลโดยใช้เทคนิคการจ าแนกข้อมูลแบบก ากับดูแล (Supervise 
Classification) โดยจ าแนกแบบความน่าจะเป็นสูงสุด (Maximum Likelihood Classification) 
และก าหนดกลุ่ มตั วอย่ างเป็ น  4 กลุ่ ม  ได้ แก่  พ้ื นที่ แหล่ งน้ า  (Water), พ้ื นที่ เกษตรกรรม 
(Agriculture),พ้ืนที่ป่าไม้ (Forest) และพ้ืนที่เมือง  ( Urban) 

การศึกษาการจ าแนกการใช้ประโยชน์ที่ดิน พ .ศ.  2556 พบว่าจากพ้ืนที่ เทศบาลเมือง
กาฬสินธุ์ที่มีขนาดพ้ืนที่ทั้งหมด 25.113 ตารางกิโลเมตร ปรากฏค่า 1) พ้ืนที่การเกษตร มีขนาดพ้ืนที่ 
1.92 ตารางกิโลเมตร คิดเป็น 7.64% 2) พ้ืนที่ป่าไม้มีขนาดพ้ืนที่ 2.856 ตารางกิโลเมตร คิดเป็น 
11.37%  3). พ้ืนที่ชุมชนเมือง มีขนาดพ้ืนที่ 19.927 ตารางกิโลเมตร คิดเป็น 79.34% 4).พ้ืนที่แหล่ง
น้ า มีขนาดพื้นที่ 0.41 ตารางกิโลเมตร คิดเป็น 1.65% แสดงได้ดังภาพที่ 32 
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ภาพประกอบที่ 32 แสดงการใช้ที่ดินของเทศบาลกาฬสินธุ์ปี 2556 

จากภาพประกอบที่ 32 จะเห็นได้ว่าพ้ืนที่ของเทศบาลกาฬสินธุ์นั้น มีพ้ืนที่ทั้งหมด 25.113 
ตารางกิโลเมตร ผลการศึกษาการจ าแนกประเภทข้อมูลได้แสดงให้เห็นพ้ืนที่ส่วนใหญ่ของเทศบาล
เมืองกาฬสินธุ์จะเป็นพ้ืนที่เมือง พื้นที่ป่าไม้ พ้ืนที่ท าการเกษตรและพ้ืนที่แหล่งน้ า ตามล าดับ ทั้งนี้ผล
การวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของเทศบาลเมืองกาฬสินธุ์ ดังตารางที่ 5  

ตารางท่ี 5 ข้อมูลการจ าแนกการใช้ประโยชน์ที่ดินของเทศบาลกาฬสินธุ์ ปี พ .ศ . 2556 
พ้ืนที่ พ้ืนที่ 

เมือง 
)ตร.กม( 

พ้ืนที่ 
การเกษตร 
)ตร.กม( 

พ้ืนที่ 
ป่าไม้ 

)ตร.กม( 

พ้ืนที่ 
น้ า 

)ตร.กม( 

พ้ืนที่ 
ทั้งหมด 
)ตร.กม( 

เทศบาล
กาฬสินธุ์ 

 
19.927 

 
1.920 

 
2.856 

 
0.410 

 
25.113 

 

การศึกษาการจ าแนกการใช้ประโยชน์ที่ดิน พ .ศ.  2557 พบว่าจากพ้ืนที่ เทศบาลเมือง
กาฬสินธุ์ที่มีขนาดพ้ืนที่ทั้งหมด 25.082 ตารางกิโลเมตร ปรากฏค่า 1) พ้ืนที่การเกษตร มีขนาดพ้ืนที่ 
1.927 ตารางกิโลเมตร คิดเป็น 7.68% 2) พ้ืนที่ป่าไม้ มีขนาดพ้ืนที่ 3.249 ตารางกิโลเมตร คิดเป็น 
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12.95% 3) พ้ืนที่ชุมชนเมือง มีขนาดพ้ืนที่ 19 374 ตารางกิโลเมตร คิดเป็น 77.24% 4) พ้ืนที่แหล่ง
น้ า มีขนาดพื้นที่ 0.532 ตารางกิโลเมตร คิดเป็น 2.13% แสดงได้ดังภาพที่ 33 

 
ภาพประกอบที่ 33 แสดงการใช้ที่ดินของเทศบาลกาฬสินธุ์ปี 2557 

จากภาพประกอบที่ 33 จะเห็นได้ว่าพ้ืนที่ของเทศบาลเมืองกาฬสินธุ์นั้น มีพ้ืนที่ทั้งหมด 
25.082 ตารางกิโลเมตร ผลการศึกษาการจ าแนกประเภทข้อมูลได้แสดงให้เห็นพ้ืนที่ส่วนใหญ่ของ
เทศบาลเมืองกาฬสินธุ์จะเป็นพ้ืนที่เมือง พ้ืนที่ป่าไม้ พ้ืนที่ท าการเกษตรและพ้ืนที่แหล่งน้ า ตามล าดับ 
ทั้งนี้ผลการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของเทศบาลเมืองกาฬสินธุ์ ดังตารางที่ 6  

ตารางท่ี 6 ข้อมูลการจ าแนกการใช้ประโยชน์ที่ดินของเทศบาลเมืองกาฬสินธุ์ ปี พ .ศ . 2557 
พ้ืนที่ พ้ืนที่ 

เมือง 
)ตร.กม( 

พ้ืนที่ 
การเกษตร 
)ตร.กม( 

พ้ืนที่ 
ป่าไม้ 

)ตร.กม( 

พ้ืนที่ 
น้ า 

)ตร.กม( 

พ้ืนที่ 
ทั้งหมด 
)ตร.กม( 

เทศบาล
กาฬสินธุ์ 

 

 
19.374 

 

 
1.929 

 
3.249 

 
0.532 

 
25.082 

 

การศึกษาการจ าแนกการใช้ประโยชน์ที่ดิน พ .ศ.  2558 พบว่าจากพ้ืนที่ เทศบาลเมือง
กาฬสินธุ์ที่มีขนาดพ้ืนที่ทั้งหมด 25.178 ตารางกิโลเมตร ปรากฏค่า 1).พ้ืนที่ การเกษตร มีขนาดพ้ืนที่ 
1.824 ตารางกิโลเมตร คิดเป็น 7.24% 2) พ้ืนที่ป่าไม้มีขนาดพ้ืนที่ 4.046 ตารางกิโลเมตร คิดเป็น 
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16.07% 3) พ้ืนที่ชุมชนเมือง มีขนาดพ้ืนที่ 18.890 ตารางกิโลเมตร คิดเป็น 75.03% 4) พ้ืนที่แหล่ง
น้ า มีขนาดพื้นที่ 0.418 ตารางกิโลเมตร คิดเป็น 1.66% แสดงได้ดังภาพที่ 34 

 
ภาพประกอบที่ 34 แสดงการใช้ที่ดินของเทศบาลกาฬสินธุ์ปี 2558 

จากภาพประกอบที่ 34 จะเห็นได้ว่าพ้ืนที่ของเทศบาลเมืองกาฬสินธุ์นั้น มีพ้ืนที่ทั้งหมด 
25.178 ตารางกิโลเมตร ผลการศึกษาการจ าแนกประเภทข้อมูลได้แสดงให้เห็นพ้ืนที่ส่วนใหญ่ของ
เทศบาลเมืองกาฬสินธุ์จะเป็นพ้ืนที่เมือง พ้ืนที่ป่าไม้ พ้ืนที่ท าการเกษตรและพ้ืนที่แหล่งน้ า ตามล าดับ 
ทั้งนี้ผลการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของเทศบาลกาฬสินธุ์ ดังตารางที่ 7  

ตารางท่ี 7 ข้อมูลการจ าแนกการใช้ประโยชน์ที่ดินของเทศบาลเมืองกาฬสินธุ์ พ .ศ . 2558 
พ้ืนที่ พ้ืนที่ 

เมือง 
)ตร.กม( 

พ้ืนที่ 
การเกษตร 
)ตร.กม( 

พ้ืนที่ 
ป่าไม้ 

)ตร.กม( 

พ้ืนที่ 
น้ า 

)ตร.กม( 

พ้ืนที่ 
ทั้งหมด 
)ตร.กม( 

เทศบาล
กาฬสินธุ์ 

 

 
18.890 
 

 
1.824 

 
4.046 

 
0.418 

 
25.178 

การศึกษาการจ าแนกการใช้ประโยชน์ที่ดิน พ .ศ.  2559 พบว่า จากพ้ืนที่เทศบาลเมือง
กาฬสินธุ์ที่มีขนาดพ้ืนที่ทั้งหมด 25.068 ตารางกิโลเมตร ปรากฏค่า 1) พ้ืนที่การเกษตร มีขนาดพ้ืนที่ 
3.124 ตารางกิโลเมตร คิดเป็น 12.46% 2) พ้ืนที่ป่าไม้ มีขนาดพ้ืนที่ 2.435 ตารางกิโลเมตร คิดเป็น 
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9.71% 3) พ้ืนที่ชุมชนเมือง มีขนาดพ้ืนที่ 19.032 ตารางกิโลเมตร คิดเป็น 75.92% 4) พ้ืนที่แหล่งน้ า 
มีขนาดพื้นที่ 0.477 ตารางกิโลเมตร คิดเป็น 1.91% แสดงได้ดังภาพที่ 35 

 
ภาพประกอบที่ 35 แสดงการใช้ที่ดินของเทศบาลกาฬสินธุ์ปี 2559 

จากภาพประกอบที่ 35 จะเห็นได้ว่าพ้ืนที่ของเทศบาลกาฬสินธุ์นั้น มีพ้ืนที่ทั้งหมด 25.068 
ตารางกิโลเมตร ผลการศึกษาการจ าแนกประเภทข้อมูลได้แสดงให้เห็นพ้ืนที่ส่วนใหญ่ของเทศบาล 
กาฬสินธุ์จะเป็นพ้ืนที่เมือง พ้ืนที่ป่าไม้ พ้ืนที่ท าการเกษตรและพ้ืนที่แหล่งน้ า ตามล าดับ ทั้งนี้ผลการ 
วิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของเทศบาลเมืองกาฬสินธุ์ ดังตารางที่ 8 

 

ตารางท่ี 8 ข้อมูลการจ าแนกการใช้ประโยชน์ที่ดินของเทศบาลเมืองกาฬสินธุ์ ปี พ .ศ . 2559 
พ้ืนที่ พ้ืนที่ 

เมือง 
)ตร.กม( 

พ้ืนที่ 
การเกษตร 
)ตร.กม( 

พ้ืนที่ 
ป่าไม้ 

)ตร.กม( 

พ้ืนที่ 
น้ า 

)ตร.กม( 

พ้ืนที่ 
ทั้งหมด 
)ตร.กม( 

เทศบาล
กาฬสินธุ์ 

 
19.032 

 

 
3.124 

 
2.435 

 
0.477 

 
25.068 

 

การศึกษาการจ าแนกการใช้ประโยชน์ที่ดิน พ .ศ.  2560 พบว่าจากพ้ืนที่ เทศบาลเมือง
กาฬสินธุ์ที่มีขนาดพ้ืนที่ทั้งหมด 25.117 ตารางกิโลเมตร ปรากฏค่า 1 ) พ้ืนที่ การเกษตร มีขนาดพ้ืนที่ 
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742.1 ตารางกิโลเมตร คิดเป็น 6.93 %2 ) พ้ืนที่ป่าไม้ มีขนาดพ้ืนที่  2.677 ตารางกิโลเมตร คิดเป็น 
10.67 %3 ) พ้ืนที่ชุมชนเมือง มีขนาดพ้ืนที่ 20.27 ตารางกิโลเมตร คิดเ ป็น 80.70 %4 .) พ้ืนที่แหล่งน้ า 

มีขนาดพื้นที่ 0.428 ดเป็นตารางกิโลเมตร คิ 1.70%  แสดงได้ดังภาพที่ 36 

 
ภาพประกอบที่ 36 แสดงการใช้ที่ดินของเทศบาลเมืองกาฬสินธุ์ปี 2560 

จากภาพประกอบที่ 36 จะเห็นได้ว่าพ้ืนที่ของเทศบาลเมืองกาฬสินธุ์นั้น มีพ้ืนที่ทั้งหมด 
25.117 ผลการศึกษาการจ าแนกประเภทข้อมูลได้แสดงให้เห็นพ้ืนที่ส่วนใหญ่ของตารางกิโลเมตร 

เทศบาลเมืองกาฬสินธุ์จะเป็นพ้ืนที่เมือง พ้ืนที่ป่าไม้ พ้ืนที่ท าการเกษตรและพ้ืนที่แหล่งน้ า ตามล าดับ  

ทั้งนี้ผลการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของเทศบาลกาฬสินธุ์ ดังตารางที่ 9 

ตารางท่ี 9 ข้อมูลการจ าแนกการใช้ประโยชน์ที่ดินของเทศบาลเมืองกาฬสินธุ์ ปี พ .ศ .2560  
พ้ืนที่ พ้ืนที่ 

เมือง 
)ตร.กม( 

พ้ืนที่ 
การเกษตร 
)ตร.กม( 

พ้ืนที่ 
ป่าไม้ 

)ตร.กม( 

พ้ืนที่ 
น้ า 

)ตร.กม( 

พ้ืนที่ 
ทั้งหมด 
)ตร.กม( 

เทศบาล
กาฬสินธุ์ 

 

 
20.27 

 
1.742 

 
2.677 

 
0.428 

 
25.117 

 

 การศึกษาการจ าแนกการใช้ประโยชน์ที่ดิน พ .ศ.  2561 พบว่า จากพ้ืนที่เทศบาล
เมืองกาฬสินธุ์ที่มีขนาดพ้ืนที่ทั้งหมด 25.065 ตารางกิโลเมตร ปรากฏค่า 1 ) พ้ืนที่การเกษตร มีขนาด
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พ้ืนที่ 2.702 ตารางกิโลเมตร คิดเป็น 10.7896 2 ) พ้ืนที่ป่าไม้ มีขนาดพ้ืนที่ 1.186 ตารางกิโลเมตร 
คิดเป็น 4.73 %3 ) พ้ืนที่ชุมชนเมือง มีขนาดพ้ืนที่ 20.798 ตารางกิโลเมตร คิดเป็น 82.97 %4 ) พ้ืนที่

แหล่งน้ า มีขนาดพื้นที่ 0.379 ตารางกิโลเมตร คิดเป็น 1.52%  แสดงได้ดังภาพที่ 37 

 
ภาพประกอบที่ 37 แสดงการใช้ที่ดินของเทศบาลเมืองกาฬสินธุ์ปี 2561 

จากภาพประกอบที่ 37 จะเห็นได้ว่าพ้ืนที่ของเทศบาลเมืองกาฬสินธุ์นั้น มีพ้ืนที่ทั้งหมด 
25.065 ตารางกิโลเมตร ผลการศึกษาการจ าแนกประเภทข้อมูลได้แสดงให้เห็นพ้ืนที่ส่วนใหญ่ของ
เทศบาล กาฬสินธุ์จะเป็นพ้ืนที่เมือง พื้นที่ป่าไม้ พื้นที่ท าการเกษตรและพ้ืนที่แหล่งน้ า ตามล าดับ ทั้งนี้
ผลการ วิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของเทศบาลกาฬสินธุ์ ดังตารางที่ 10  

 

ตารางท่ี 10 ข้อมูลการจ าแนกการใช้ประโยชน์ที่ดินของเทศบาลเมืองกาฬสินธุ์ ปี พ .ศ . 2561 
พ้ืนที่ พ้ืนที่ 

เมือง 
)ตร.กม( 

พ้ืนที่ 
การเกษตร 
)ตร.กม( 

พ้ืนที่ 
ป่าไม้ 

)ตร.กม( 

พ้ืนที่ 
น้ า 

)ตร.กม( 

พ้ืนที่ 
ทั้งหมด 
)ตร.กม( 

เทศบาล
กาฬสินธุ์ 

 
20.798 

 

 
2.702 

 
1.186 

 
0.379 

 
25.065 

 



 

 

  38 

 การศึกษาการจ าแนกการใช้ประโยชน์ที่ดิน พ .ศ.  2562 พบว่าจาก พ้ืนที่เทศบาล
เมืองกาฬสินธุ์ที่มีขนาดพ้ืนที่ทั้งหมด 25.156 ตารางกิโลเมตร ปรากฏค่า 1) พ้ืนที่การเกษตร มี ขนาด
พ้ืนที่ 0.999 ตารางกิโลเมตร คิดเป็น 3.97% 2) พ้ืนที่ป่าไม้ มีขนาดพ้ืนที่ 1.499 ตารางกิโลเมตร คิด 
เป็น 5.96% 3) พ้ืนที่ชุมชนเมือง มีขนาดพ้ืนที่ 22.258 ตารางกิโลเมตร คิดเป็น 88.48% 4) พ้ืนที่
แหล่งน้ า มีขนาดพื้นที่ 0.400 ตารางกิโลเมตร คิดเป็น 1.59% แสดงได้ดังภาพที่ 38 

 
ภาพประกอบที่ 38 แสดงการใช้ที่ดินของเทศบาลกาฬสินธุ์ปี 2562 

จากภาพประกอบที่ 38 จะเห็นได้ว่าพ้ืนที่ของเทศบาลเมืองกาฬสินธุ์นั้น มีพ้ืนที่ทั้งหมด 
25.156 ตารางกิโลเมตร ผลการศึกษาการจ าแนกประเภทข้อมูลได้แสดงให้เห็นพ้ืนที่ส่วนใหญ่ของ
เทศบาล กาฬสินธุ์จะเป็นพ้ืนที่เมือง พื้นที่ป่าไม้ พื้นที่ท าการเกษตรและพ้ืนที่แหล่งน้ า ตามล าดับ ทั้งนี้
ผลการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของเทศบาลเมืองกาฬสินธุ์ ดังตารางที่ 11  

 

ตารางท่ี 11 ข้อมูลการจ าแนกการใช้ประโยชน์ที่ดินของเทศบาลเมืองกาฬสินธุ์ ปี พ .ศ . 2562 
พ้ืนที่ พ้ืนที่ 

เมือง 
)ตร.กม( 

พ้ืนที่ 
การเกษตร 
)ตร.กม( 

พ้ืนที่ 
ป่าไม้ 

)ตร.กม( 

พ้ืนที่ 
น้ า 

)ตร.กม( 

พ้ืนที่ 
ทั้งหมด 
)ตร.กม( 

เทศบาล
กาฬสินธุ์ 

 

 
22.258 

 

 
0.999 

 
1.499 

 
0.400 

 
25.156 
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4.2 การศึกษาอุณหภูมิพื้นผิวดินในช่วงปี พ .ศ . 2556 ถึงปี พ .ศ . 2562 
 ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาลเมืองกาฬสินธุ์ที่ได้จากการวิเคราะห์ข้อมูล

ดาวเทียม Landsat 8 ของวันที่ 18 ธันวาคม 2556 ช่วงคลื่น TIR ด้วยวิธี Spit-window พบว่ามี
อุณหภูมิสูงสุดอยู่ ที่ 37.81 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 15.25 องศาเซลเซียส และอุณหภูมิ
เฉลี่ยนอยู่ที่ 26.53 องศาเซลเซียส โดยการวิเคราะห์อุณหภูมิพ้ืนผิวของเทศบาลเมืองกาฬสินธุ์สามารถ
แสดงได้ดังตารางที่ 12 

ตารางท่ี 12 ค่าอุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์ปี 2556 
พ้ืนที่ ค่าต่ าสุด 

)องศา 
เซลเซียส( 

ค่าสูงสุด 
)องศา 

เซลเซียส( 

ค่าเฉลี่ย 
)องศา 

เซลเซียส( 

ค่าเบี่ยงเบน 
มาตรฐาน 

เทศบาล
กาฬสินธุ์ 

 

 
15.25 

 

 
37.81 

 
26.53 

 
1.97 

 

 
ภาพประกอบที่ 39 แสดงอุณหภูมิพ้ืนผิวของปี 2556 

จากภาพประกอบที่ 39 จะแสดงให้เห็นว่าผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาลเมือง
กาฬสินธุ์ที่ได้จากการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของวันที่ 22 พฤศจิกายน 2556 ช่วงคลื่น 
TIR ด้วยวิธี Split-window พบว่ามีอุณหภูมิสูงสุดอยู่ที่ 37.81 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 
15.25 องศา เซลเซียสและอุณหภูมิเฉลี่ยนอยู่ที่ 25.53 องศาเซลเซียส 
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ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาลเมืองกาฬสินธุ์ที่ได้จากการวิเคราะห์ข้อมูล
ดาวเทียม Landsat 8 ของวันที่ 21 ธันวาคม 2557 ช่วงคลื่น TIR ด้วยวิธี Spit-window พบว่ามี
อุณหภูมิสูงสุดอยู่ ที่ 38.69 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 26.17 องศาเซลเซียส และอุณหภูมิ
เฉลี่ยนอยู่ที่ 32.43 องศาเซลเซียส โดยการวิเคราะห์อุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์สามารถ
แสดงได้ดงัตารางที่ 13 

ตารางท่ี 13 ค่าอุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์ปี 2557 
พ้ืนที่ ค่าต่ าสุด 

)องศา 
เซลเซียส( 

ค่าสูงสุด 
)องศา 

เซลเซียส( 

ค่าเฉลี่ย 
)องศา 

เซลเซียส( 

ค่าเบี่ยงเบน 
มาตรฐาน 

เทศบาล
กาฬสินธุ์ 

 
26.17 

 

 
38.69 

 
32.43 

 
2.11 

 

 
ภาพประกอบที่ 40 แสดงอุณหภูมิพ้ืนผิวของปี 2557 

จากภาพประกอบที่ 40 จะแสดงให้เห็นว่า ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาล
กาฬสินธุ์ที่ได้จากการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของวันที่ 21 ธันวาคม 2557 ช่วงคลื่น 
TIR ด้วยวิธี Split window พบว่ามีอุณหภูมิสูงสุดอยู่ที่ 38.69 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 
26.17 องศาเซลเซียสและอุณหภูมิเฉลี่ยนอยู่ที่ 32.43 องศาเซลเซียส 
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ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาลกาฬสินธุ์ที่ได้จากการวิเคราะห์ข้อมูลดาวเทียม 
Landsat 8 ของวันที่ 22 พฤศจิกายน 2558 ช่วงคลื่น TIR ด้วยวิธี Split-window พบว่ามีอุณหภูมิ
สูงสุด อยู่ที่ 42.43 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 29.52 องศาเซลเซียส และอุณหภูมิเฉลี่ยนอยู่ที่ 
35.97 องศาเซลเซียส โดยการวิเคราะห์อุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์สามารถแสดงได้ดังตาราง
ที ่14 

ตารางท่ี 14 ค่าอุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์ปี 2558 
พ้ืนที่ ค่าต่ าสุด 

)องศา 
เซลเซียส( 

ค่าสูงสุด 
)องศา 

เซลเซียส( 

ค่าเฉลี่ย 
)องศา 

เซลเซียส( 

ค่าเบี่ยงเบน 
มาตรฐาน 

เทศบาล
กาฬสินธุ์ 

 
29.52 

 

 
42.43 

 
35.97 

 
1.67 

 

 

 

 
ภาพประกอบที่ 41 แสดงอุณหภูมิพ้ืนผิวของปี 2558 

จากภาพประกอบที่ 41 จะแสดงให้เห็นว่า ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาล
กาฬสินธุ์ที่ ได้จากการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของวันที่ 22 พฤศจิกายน 2558 ช่วงคลื่น 
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TIR ด้วยวิธี Split-window พบว่ามีอุณหภูมิสูงสุดอยู่ที่ 42.43 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 
29.52 องศาเซลเซียสและอุณหภูมิเฉลี่ยอยู่ท่ี 35.97 องศาเซลเซียส 

 ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาลกาฬสินธุ์ที่ได้จากการวิเคราะห์ข้อมูล
ดาวเทียม Landsat 8 ของวันที่ 10 ธันวาคม 2559 ช่วงคลื่น TIR ด้วยวิธี Split-window พบว่ามี
อุณหภูมิสูงสุดอยู่ ที่ 37.22 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 25.38 องศาเซลเซียส และอุณหภูมิ

เฉลี่ยนอยู่ที่ 31.30 องศาเซลเซียส โดยการวิเคราะห์อุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์สามารถ
แสดงได้ดังตารางที่ 15 

ตารางท่ี 15 ค่าอุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์ปี 2559 
พ้ืนที่ ค่าต่ าสุด 

)องศา 
เซลเซียส( 

ค่าสูงสุด 
)องศา 

เซลเซียส( 

ค่าเฉลี่ย 
)องศา 

เซลเซียส( 

ค่าเบี่ยงเบน 
มาตรฐาน 

เทศบาล
กาฬสินธุ์ 

 
25.38 

 

 
37.22 

 
31.30 

 
2.96 

 

 
ภาพประกอบที่ 42 แสดงอุณหภูมิพ้ืนผิวของปี 2559 

จากภาพประกอบที่ 42 จะแสดงให้เห็นว่า ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาล
กาฬสินธุ์ที่ ได้จากการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของวันที่ 10 ธันวาคม 2559 ช่วงคลื่น 
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TIR ด้วยวิธี Split window พบว่ามีอุณหภูมิสูงสุดอยู่ที่ 37.22 องศาเซลเซียส อุณหภูมิต่ ำสุดอยู่ที่ 
25.38 องศาเซล เซียส และอุณหภูมิเฉลี่ยนอยู่ที่ 31.30 องศาเซลเซียส  

 ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาลกาฬสินธุ์ที่ได้จากการวิเคราะห์ข้อมูล
ดาวเทียม Landsat 8 ของวันที่ 27 พฤศจิกายน 2560 ช่วงคลื่น TIR ด้วยวิธี Split-window พบว่ามี
อุณหภูมิสูงสุด อยู่ที่ 33.46 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 19.00 องศาเซลเซียส และอุณหภูมิ
เฉลี่ยนอยู่ที่ 26.23 องศาเซลเซียส โดยการวิเคราะห์อุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์สามารถ
แสดงได้ดังตารางที่ 16 

ตารางท่ี 16 ค่าอุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์ปี 2560 
พ้ืนที่ ค่าต่ าสุด 

)องศา 
เซลเซียส( 

ค่าสูงสุด 
)องศา 

เซลเซียส( 

ค่าเฉลี่ย 
)องศา 

เซลเซียส( 

ค่าเบี่ยงเบน 
มาตรฐาน 

เทศบาล
กาฬสินธุ์ 

 
19.00 

 

 
33.46 

 
26.23 

 
2.57 

 

 

 
ภาพประกอบที่ 43 แสดงอุณหภูมิพ้ืนผิวของปี 2560 
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จากภาพประกอบที่ 43 จะแสดงให้เห็นว่าผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาลกาฬสินธุ์ 
ที่ได้จากการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของวันที่ 27 พฤศจิกายน 2560 ช่วงคลื่น TIR ด้วย
วิธี Split-window พบว่ามีอุณหภูมิสูงสุดอยู่ที่ 33.46 องศาเซลเซียส อุณหภูมิต่ ำสุดอยู่ที่ 19.00 
องศา เซลเซียส และอุณหภูมิเฉลี่ยนอยู่ที่ 33.46 องศาเซลเซียส  

 ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาลกาฬสินธุ์ที่ได้จากการวิเคราะห์ข้อมูล
ดาวเทียม Landsat 8 ของวันที่ 16 ธันวาคม 2561 ช่วงคลื่น TIR ด้วยวิธี Split-window พบว่ามี
อุณหภูมิสูงสุดอยู่ที่ 41.49 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 27.08 องศาเซลเซียส และอุณหภูมิ
เฉลี่ยนอยู่ที่ 34.25 องศา เซลเซียส โดยการวิเคราะห์อุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์สามารถ
แสดงได้ดังตารางที่ 17 

ตารางท่ี 17 ค่าอุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์ปี 2561 
พ้ืนที่ ค่าต่ าสุด 

)องศา 
เซลเซียส( 

ค่าสูงสุด 
)องศา 

เซลเซียส( 

ค่าเฉลี่ย 
)องศา 

เซลเซียส( 

ค่าเบี่ยงเบน 
มาตรฐาน 

เทศบาล
กาฬสินธุ์ 

 
27.08 

 

 
41.49 

 
34.25 

 
2.65 

 

 
ภาพประกอบที่ 44 แสดงอุณหภูมิพ้ืนผิวของปี 2561 
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จากภาพประกอบที่ 44 จะแสดงให้เห็นว่า ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาล
กาฬสินธุ์ ที่ได้จากการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของวันที่ 16 ธันวาคม 2561 ช่วงคลื่น 
TIR ด้วยวิธี Split-window พบว่ามีอุณหภูมิสูงสุดอยู่ที่ 41.49 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 
27.08 องศา เซลเซียส และอุณหภูมิเฉลี่ยนอยู่ที่ 34.25 องศาเซลเซียส 

 ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาลกาฬสินธุ์ที่ได้จากการวิเคราะห์ข้อมูล
ดาวเทียม Landsat 8 ของวันที่ 3 ธันวาคม 2562 ช่วงคลื่น TIR ด้วยวิธี Split-window พบว่ามี
อุณหภูมิสูงสุดอยู่ที่ 37.55 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 22.67 องศาเซลเซียส และอุณหภูมิ
เฉลี่ยนอยู่ที่ 30.11 องศา เซลเซียส โดยการวิเคราะห์อุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์สามารถ
แสดงได้ดังตารางที่ 18 

ตารางท่ี 18 ค่าอุณหภูมิพ้ืนผิวของเทศบาลกาฬสินธุ์ปี 2562 
พ้ืนที่ ค่าต่ าสุด 

)องศา 
เซลเซียส( 

ค่าสูงสุด 
)องศา 

เซลเซียส( 

ค่าเฉลี่ย 
)องศา 

เซลเซียส( 

ค่าเบี่ยงเบน 
มาตรฐาน 

เทศบาล
กาฬสินธุ์ 

 

 
22.67 

 

 
37.55 

 
30.11 

 
1.98 

 

 
ภาพประกอบที่ 45 แสดงอุณหภูมิพ้ืนผิวของปี 2562 
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จากภาพประกอบที่ 45 จะแสดงให้เห็นว่า ผลการวิเคราะห์อุณหภูมิพ้ืนผิวในเทศบาล
กาฬสินธุ์ ที่ได้จากการวิเคราะห์ข้อมูลดาวเทียม Landsat 8 ของวันที่ 3 ธันวาคม 2562 ช่วงคลื่น TIR 
ด้วยวิธี Split-window พบว่ามีอุณหภูมิสูงสุดอยู่ที่ 37.55 องศาเซลเซียส อุณหภูมิต่ าสุดอยู่ที่ 22.67 
องศาเซลเซียส และอุณหภูมิเฉลี่ยนอยู่ที่ 30.11 องศาเซลเซียส 

4.3 การวิเคราะห์การเปลี่ยนแปลงของอุณหภูมิ 
จากการวิเคราะห์การเปลี่ยนแปลงของอุณหภูมิพ้ืนผิวเทศบาลกาฬสินธุ์ของการใช้ประโยชน์

ที่ดิน ในจังหวัดกาฬสินธุ์ที่สามารถวิเคราะห์ได้จากข้อมูลดาวเทียมสามารถแสดงได้ดัง (ภาพปร ะกอบ
ที่ 4.15) 

 
ภาพประกอบที่ 46 ภาพแสดงการเปลี่ยนแปลงพ้ืนที่และอณหภูมิ 

จากภาพประกอบที่ 46 สามารถอธิบายค่าเทศบาลกาฬสินธุ์ โดยแสดงเส้นกราฟในแกน X 
ซึ่ง ในแกน X ได้ถูกจ าแนกการใช้ประโยชน์ที่ดินออกเป็น 4 ประเภทคือ 1) พ้ืนที่เมือง (Urban) 2) 
พ้ืนที่ การเกษตร (Agriculture) 3) พ้ืนที่ป่าไม้ (Forest) 4) พ้ืนที่แหล่งน้ า  ( Water) จากสมมติฐาน
ของการวิจัย ในครั้งนี้คือพื้นที่ที่เป็นตัวเมืองนั้นมีอุณหภูมิสูงกว่าพ้ืนที่การใช้ประโยชน์ที่ดินประเภทอ่ืน 
ๆ จากกราฟใน แกน Y ฝั่งด้านซ้ายอุณหภูมิ มีหน่วยขององศาเซลเซียส ฝั่งด้านขวาจะแสดงขนาดของ
พ้ืนที่ของการใช้ ประโยชน์ที่ดิน มีหน่วยเป็นตารางกิโลเมตร ทั้งนี้จากภาพประกอบที่ 4.2 ในภาพจะ
แสดงให้เห็นว่า แผนภูมิของอุณหภูมิ จะเปลี่ยนไปตามการใช้ประโยชน์ของที่ดินในแต่ละประเภท จาก
ผลการศึกษานี้ ในปี พ .ศ. 2556 ซึ่งปรากฏอุณหภูมิพ้ืนผิวเท่ากับ 26.53 องศาเซลเซียส ในปี พ .ศ.
2557 ซึ่งปรากฏอุณหภูมิพ้ืนผิวเท่ากับ 32.43 องศาเซลเซียส ในปี พ .ศ. 2558 ซึ่งปรากฏอุณหภูมิ
พ้ืนผิวเท่ากับ 35.97 องศา เซลเซียส ในปี พ .ศ. 2559 ซึ่งปรากฏอุณหภูมิพ้ืนผิวเท่ากับ 31.30 องศา
เซลเซียส ในปี พ .ศ. 2560 ซึ่งปรากฏ อุณหภูมิพ้ืนผิวเท่ากับ 26.23 องศาเซลเซียส ในปี พ .ศ. 2561 ซึ่ง
ปรากฏอุณหภูมิพ้ืนผิวเท่ากับ 34.25 องศาเซลเซียสและในปี พ .ศ. 2562 ซึ่งปรากฏอุณหภูมิพ้ืนผิว
เท่ากับ 30.11 องศาเซลเซียส จากกราฟแสดงความสัมพันธ์นั้นอุณหภูมิที่มีการขึ้นลงอาจจะเป็น



 

 

  47 

เพราะว่าโลกของเราช่วงที่ผ่านมานั้นมีการเปลี่ยนแปลงไปอย่างมากบางปีมีอุณหภูมิที่ร้อนถึงร้อนมาก 
บางปีมีอุณหภูมิที่หนาวถึงหนาวมาก ดังนั้นจึงท าให้อุณหภูมิมีค่าเชิงขึ้นลงซึ่งข้อมูลข้างต้นนั้นจะแสดง
ให้เห็นว่ามีการเปลี่ยนแปลงเกิดขึ้นจึงท าให้การใช้ประโยชน์ของที่ดินนั้นมีอุณหภูมิสูงขึ้นไปตามการใช้
ประโยชน์ของที่ดิน ตามล าดับ 

4.4 การตรวจสอบความถูกต้องด้วยวิธีการทางสถิติแคปปา 
ตรวจสอบความถูกต้องของการจ าแนกการใช้ประโยชน์ที่ดิน โดยการสุ่มจุดตัวอย่างจ านวน 

90 จุดโดยการเปรียบเทียบกับ Google Earth ดังต่อไปนี้  

4.4.1 การตรวจสอบความถูกต้องด้วยวิธีการทางสถิติแคปปา ปี พ .ศ . 2556 

ตารางท่ี 19 ผลการตรวจสอบความถูกต้อง พ .ศ . 2556 

 

 จากข้อมูลตารางที่ 19 เมื่อค านวณค่าความถูกต้องโดยรวม (Overall Accuracy) ร้อยละ 90.83 พบว่ามีค่า
สัมประสิทธิ์แคปปา  ( Kappa Statistics) ของความสอดคล้องเท่ากับ 0. 940 เมื่อพิจารณาเฉพาะคลาส 
(class) ของพ้ืนที่เมืองพบว่า มีค่าความถูกต้องของผู้ผลิต (producer’s accuracy) เท่ากับร้อยละ 
89.66  มีความผิดพลาดส่วนที่ขาดหายไป  ( omission error) เท่ากับร้อยละ 10.34  มีค่าความถูกต้อง

ข้อมูลการ
จ าแนก 

พ้ืนที่
เมือง 

พ้ืนทีก่ารเกษตร พ้ืนทีป่่าไม้ พ้ืนทีน่้ า รวม user’s 
accuracy 

(%) 

พ้ืนทีเ่มือง 26 2 2 - 30 86.67 

พ้ืนทีก่ารเกษตร - 28 - 2 30 93.33 

พ้ืนที่ป่าไม้ 2 - 28 - 30 93.33 

พ้ืนทีน่้ า 1 2 - 27 30 90.00 

รวม 26 27 29 38 120  

producer’s 
accuracy (%) 

89.66 87.50 93.33 93.31  

Overall 
accuracy (%) 

90.83 
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ของผู้ ใช้  (user’s accuracy) เท่ ากับ ร้อยละ 86.67  มี ค่ าความผิดพลาดส่ วนที่ เกิ น เข้ ามา 
(commission error) เท่ากับร้อยละ 13.33 

 4.4.2 การตรวจสอบความถูกต้องด้วยวิธีการทางสถิติแคปปา ปี พ .ศ . 2557 

ตารางท่ี 20 ผลการตรวจสอบความถูกต้อง พ .ศ . 2557 

 

 จากข้อมูลตารางที่ 20 เมื่อค านวณค่าความถูกต้องโดยรวม (Overall Accuracy) ร้อยละ 92.50 พบว่ามีค่า
สัมประสิทธิ์แคปปา  ( Kappa Statistics) ของความสอดคล้องเท่ากับ 0. 948 เมื่อพิจารณาเฉพาะคลาส 
(class) ของพ้ืนที่เมืองพบว่า มีค่าความถูกต้องของผู้ผลิต (producer’s accuracy) เท่ากับร้อยละ 
87.87  มีความผิดพลาดส่วนที่ขาดหายไป (omission error) เท่ากับร้อยละ 12.13  มีค่าความถูกต้อง
ของผู้ ใช้  (user’s accuracy) เท่ ากับ ร้อยละ 96.67  มี ค่ าความผิดพลาดส่ วนที่ เกิ น เข้ ามา 
(commission error) เท่ากับร้อยละ 3.33 

 4.4.3 การตรวจสอบความถูกต้องด้วยวิธีการทางสถิติแคปปา ปี พ .ศ . 2558 

 

ข้อมูลการ
จ าแนก 

พ้ืนที่
เมือง 

พ้ืนทีก่ารเกษตร พ้ืนทีป่่าไม้ พ้ืนทีน่้ า รวม user’s 
accuracy 

(%) 

พ้ืนทีเ่มือง 29 - 1 - 30 96.67 

พ้ืนทีก่ารเกษตร 1 28 1 - 30 93.33 

พ้ืนที่ป่าไม้ 3 - 26 1 30 86.67 

พ้ืนทีน่้ า - 2 - 28 30 93.33 

รวม 33 30 28 29 120  

producer’s 
accuracy (%) 

87.87 93.33 92.86 95.55   

Overall 
accuracy (%) 

92.50 
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ตารางท่ี 21 ผลการตรวจสอบความถูกต้อง พ .ศ . 2558 

 

 จากข้อมูลตารางที่ 21 เมื่อค านวณค่าความถูกต้องโดยรวม (Overall Accuracy) ร้อยละ 90.83พบว่ามีค่า
สัมประสิทธิ์แคปปา  ( Kappa Statistics) ของความสอดคล้องเท่ากับ 0. 938 เมื่อพิจารณาเฉพาะคลาส 
(class) ของพ้ืนที่เมืองพบว่า มีค่าความถูกต้องของผู้ผลิต (producer’s accuracy) เท่ากับร้อยละ 
90.32 มีความผิดพลาดส่วนที่ขาดหายไป (omission error) เท่ากับร้อยละ 9.68 มีค่าความถูกต้อง
ของผู้ ใช้  (user’s accuracy) เท่ ากับ ร้อยละ 93.33  มี ค่ าความผิดพลาดส่ วนที่ เกิ น เข้ ามา 
(commission error) เท่ากับร้อยละ 6.67 

  

 

 

 

 

ข้อมูลการ
จ าแนก 

พ้ืนที่
เมือง 

พ้ืนทีก่ารเกษตร พ้ืนทีป่่าไม้ พ้ืนทีน่้ า รวม user’s 
accuracy 

(%) 

พ้ืนทีเ่มือง 28 - 2 - 30 93.33 

พ้ืนทีก่ารเกษตร 1 26 1 2 30 86.67 

พ้ืนที่ป่าไม้ - 2 28 - 30 93.33 

พ้ืนทีน่้ า 2 1 - 27 30 90.00 

รวม 31 29 31 29 120  

producer’s 
accuracy (%) 

90.32 83.66 90.32 93.31   

Overall 
accuracy (%) 

90.83 
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4.4.4 การตรวจสอบความถูกต้องด้วยวิธีการทางสถิติแคปปา ปี พ .ศ . 2559 

ตารางท่ี 22 ผลการตรวจสอบความถูกต้อง พ .ศ . 2559 

 

 จากข้อมูลตารางที่ 22 เมื่อค านวณค่าความถูกต้องโดยรวม (Overall Accuracy) ร้อยละ 89.17 พบว่ามีค่า
สัมประสิทธิ์แคปปา  ( Kappa Statistics) ของความสอดคล้องเท่ากับ 0. 929 เมื่อพิจารณาเฉพาะคลาส 
(class) ของพ้ืนที่เมืองพบว่า มีค่าความถูกต้องของผู้ผลิต (producer’s accuracy) เท่ากับร้อยละ 
89.29  มีความผิดพลาดส่วนที่ขาดหายไป (omission error) เท่ากับร้อยละ 10.71  มีค่าความถูกต้อง
ของผู้ ใช้  (user’s accuracy) เท่ ากับ ร้อยละ 83.33  มี ค่ าความผิดพลาดส่ วนที่ เกิ น เข้ ามา 
(commission error) เท่ากับร้อยละ 16.67 

 

 

 

 

ข้อมูลการ
จ าแนก 

พ้ืนที่
เมือง 

พ้ืนทีก่ารเกษตร พ้ืนทีป่่าไม้ พ้ืนทีน่้ า รวม user’s 
accuracy 

(%) 

พ้ืนทีเ่มือง 25 2 3 - 30 83.33 

พ้ืนทีก่ารเกษตร 1 27 - 2 30 90.00 

พ้ืนที่ป่าไม้ 1 1 27 1 30 90.00 

พ้ืนทีน่้ า 1 - 1 28 30 93.33 

รวม 28 30 31 31 120  

producer’s 
accuracy (%) 

89.29 90.00 87.10 90.32   

Overall 
accuracy (%) 

89.17 
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4.4.5 การตรวจสอบความถูกต้องด้วยวิธีการทางสถิติแคปปา ปี พ .ศ . 2560 

ตารางท่ี 23 ผลการตรวจสอบความถูกต้อง พ .ศ . 2560 

 

 จากข้อมูลตารางที่  23 เมื่อค านวณค่าความถูกต้องโดยรวม (Overall Accuracy) ร้อยละ 88.33 พบว่ามี
ค่าสัมประสิทธิแคปปา  ( Kappa Statistics) ของความสอดคล้องเท่ากับ 0. 922 เมื่อพิจารณาเฉพาะ
คลาส (class) ของพ้ืนที่เมืองพบว่า มีค่าความถูกต้องของผู้ผลิต (producer’s accuracy) เท่ากับร้อย
ละ 90.00  มีความผิดพลาดส่วนที่ขาดหายไป (omission error) เท่ากับร้อยละ 10.00  มีค่าความ
ถูกต้องของผู้ใช้ (user’s accuracy) เท่ากับร้อยละ 90.00  มีค่าความผิดพลาดส่วนที่เกินเข้ามา 
(commission error) เท่ากับร้อยละ 10.00 

  
 
 
 
 

ข้อมูลการ
จ าแนก 

พ้ืนที่
เมือง 

พ้ืนทีก่ารเกษตร พ้ืนทีป่่าไม้ พ้ืนทีน่้ า รวม user’s 
accuracy 

(%) 

พ้ืนทีเ่มือง 27 - 2 1 30 90.00 

พ้ืนทีก่ารเกษตร 3 24 1 2 30 80.00 

พ้ืนที่ป่าไม้ - 3 26 1 30 86.67 

พ้ืนทีน่้ า - 1 - 29 30 96.67 

รวม 30 28 29 33 120  

producer’s 
accuracy (%) 

90.00 85.71 89.65 87.87   

Overall 
accuracy (%) 

88.33 
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4.4.6 การตรวจสอบความถูกต้องด้วยวิธีการทางสถิติแคปปา ปี พ .ศ . 2561 
ตารางท่ี 24 ผลการตรวจสอบความถูกต้อง พ .ศ . 2561 

 

 จากข้อมูลตารางที่ 24 เมื่อค านวณค่าความถูกต้องโดยรวม (Overall Accuracy) ร้อยละ 92.50 พบว่ามีค่า
สัมประสิทธิ์แคปปา  ( Kappa Statistics) ของความสอดคล้องเท่ากับ 0. 948 เมื่อพิจารณาเฉพาะคลาส 
(class) ของพ้ืนที่เมืองพบว่า มีค่าความถูกต้องของผู้ผลิต (producer’s accuracy) เท่ากับร้อยละ 
87.10  มีความผิดพลาดส่วนที่ขาดหายไป (omission error) เท่ากับร้อยละ 12.90 มีค่าความถูกต้อง
ของผู้ ใช้  (user’s accuracy) เท่ ากับ ร้อยละ 90.00  มี ค่ าความผิดพลาดส่ วนที่ เกิ น เข้ ามา 
(commission error) เท่ากับร้อยละ 10.00 

  
 
 
 
 

ข้อมูลการ
จ าแนก 

พ้ืนที่
เมือง 

พ้ืนทีก่ารเกษตร พ้ืนทีป่่าไม้ พ้ืนทีน่้ า รวม user’s 
accuracy 

(%) 

พ้ืนทีเ่มือง 27 1 1 1 30 90.00 

พ้ืนทีก่ารเกษตร 1 28 - 1 30 93.33 

พ้ืนที่ป่าไม้ 1 1 28 - 30 93.33 

พ้ืนทีน่้ า 2 - - 28 30 93.33 

รวม 31 30 29 30 120  

producer’s 
accuracy (%) 

87.10 93.33 95.55 93.33   

Overall 
accuracy (%) 

92.50 
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4.4.6 การตรวจสอบความถูกต้องด้วยวิธีการทางสถิติแคปปา ปี พ .ศ . 2562 
ตารางท่ี 25 ผลการตรวจสอบความถูกต้อง พ .ศ . 2562 

 

 จากข้อมูลตารางที่ 25 เมื่อค านวณค่าความถูกต้องโดยรวม (Overall Accuracy) ร้อยละ 86.67 พบว่ามีค่า
สัมประสิทธิ์แคปปา  ( Kappa Statistics) ของความสอดคล้องเท่ากับ 0. 909 เมื่อพิจารณาเฉพาะคลาส 
(class) ของพ้ืนที่เมืองพบว่า มีค่าความถูกต้องของผู้ผลิต (producer’s accuracy) เท่ากับร้อยละ 
84.38  มีความผิดพลาดส่วนที่ขาดหายไป (omission error) เท่ากับร้อยละ 15.62 มีค่าความถูกต้อง
ของผู้ ใช้  (user’s accuracy) เท่ ากับ ร้อยละ 90.00  มี ค่ าความผิดพลาดส่ วนที่ เกิ น เข้ ามา 
(commission error) เท่ากับร้อยละ 10.00 

4.5 การหาความสัมพันธ์ระหว่างอุณหภูมิพื้นผิวเฉลี่ยกับอุณหภูมิกรมอุตุนิยมวิทยาเฉลี่ย ปี พ .ศ .
2556 ถึงปี พ .ศ . 2562 
 ผลจากการวิเคราะห์ความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวกับอุณภูมิกรมอุตุ ดังภาพ 4.16 ผู้
ศึกษาได้น าข้อมูลที่วิเคราะห์ได้จากดาวเทียมมาหาความสัมพันธ์กับอุณหภูมิของกรมอุตุนิยมวิทยา 
เมื่อสร้างสมการเชิงเส้นของข้อมูลอุณหภูมิพ้ืนผิวจากกรมอุตุนิยมวิทยาพบว่าค่าสมการเชิงเส้น r2

ข้อมูลการ
จ าแนก 

พ้ืนที่
เมือง 

พ้ืนทีก่ารเกษตร พ้ืนทีป่่าไม้ พ้ืนทีน่้ า รวม user’s 
accuracy 

(%) 

พ้ืนทีเ่มือง 27 1 1 1 30 90.00 

พ้ืนทีก่ารเกษตร 1 28 - 1 30 93.33 

พ้ืนที่ป่าไม้ 1 1 28 - 30 93.33 

พ้ืนทีน่้ า 2 - - 28 30 93.33 

รวม 31 30 29 30 120  

producer’s 
accuracy (%) 

87.10 93.33 95.55 93.33   

Overall 
accuracy (%) 

86.67 
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เท่ากับ 0.4379 แต่เมื่อน าข้อมูลที่วิเคราะห์ได้จากดาวเทียมกับอุณหภูมิของกรมอุตุนิยมวิทยา เมื่อ
สร้างสมการเชิงเส้นของข้อมูลอุณหภูมิพ้ืนผิวจากกรมอุตุนิยมวิทยาพบว่าค่าสมการเชิงเส้น r2เท่ากับ 
0.0117 ดังภาพ 47 

 
ภาพประกอบที่ 47 กราฟแสดงความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยกับอุณหภูมิกรม

อุตุนิยมวิทยาเฉลี่ย 
 จากการหาความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยกับอุณหภูมิกรมอุตุนิยมวิทยาเฉลี่ยในปี
พ .ศ . 2556 ถึงปี พ .ศ.  2562 พบว่า พ .ศ. 2556 พ้ืนที่ชุมชนเมืองมีอุณหภูมิพ้ืนผิวเฉลี่ยสูงที่สุด 37.81 
องศาเซลเซียส เมื่อน าค่าอุณหภูมิพ้ืนผิวที่วิเคราะห์ได้มาตรวจสอบกับอุณหภูมิของกรมอุตุนิยมวิทยาปี 
พ .ศ. 2556 ก็พบว่ามีความคลาดเคลื่อนอยู่ที่ 9.546 ส่วนข้อมูลจากกรมอุตุนิยมวิทยาปรากฏว่า 41.8 
องศาเซลเซียส ในปี พ .ศ . 2557 ก็พบว่ามีความคลาดเคลื่อนอยู่ที่ 2.056 โดยข้อมูลที่วิเคราะห์ได้จาก
ดาวเทียมพบว่ามีค่าอุณหภูมิพ้ืนผิวอยู่ที่ 38.69 องศาเซลเซียส ส่วนข้อมูลจากกรมอุตุนิยมวิทยา
ปรากฏว่า 39.5 องศาเซลเซียส ในปี พ .ศ . 2558 ก็พบว่ามีความคลาดเคลื่อนอยู่ที่ 1.5% โดยข้อมูลที่
วิเคราะห์ได้จากดาวเทียมพบว่ามีค่า อุณหภูมิพ้ืนผิวอยู่ที่ 42.43 องศาเซลเซียส ส่วนข้อมูลจากกรม
อุตุนิยมวิทยาปรากฎว่า 41.8 องศาเซลเซียส ในปี พ .ศ. 2559 ก็พบว่ามีความคลาดเคลื่อนอยู่ที่ 1.41% 
โดยข้อมูลที่วิเคราะห์ได้จากดาวเทียม พบว่ามีค่าอุณหภูมิพ้ืนผิวอยู่ที่ 37.22 องศาเซลเซียส ส่วนข้อมูล
จากกรมอุตุนิยมวิทยาปรากฏว่า 36.7 องศาเซลเซียส ในปี พ .ศ. 2560 ก็พบว่ามีความคลาดเคลื่อนอยู่
ที่ 3.57% โดยข้อมูลที่วิเคราะห์ได้จาก ดาวเทียมพบว่ามีค่าอุณหภูมิพ้ืนผิวอยู่ที่ 33.46 องศาเซลเซียส 
ส่วนข้อมูลจากกรมอุตุนิยมวิทยาปรากฏว่า 34.7 องศาเซลเซียส ในปี พ .ศ. 2561 ก็พบว่ามีความ
คลาดเคลื่อนอยู่ที่ 14.939% โดยข้อมูลที่วิเคราะห์ได้ จากดาวเทียมพบว่ามีค่าอุณหภูมิพ้ืนผิวอยู่ที่ 
41.49 องศาเซลเซียส ส่วนข้อมูลจากกรมอุตุนิยมวิทยา ปรากฏว่า 36.1 องศาเซลเซียส และปี พ .ศ.
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2562 ก็พบว่ามีความคลาดเคลื่อนอยู่ที่ 2.46% โดยข้อมูลที่วิเคราะห์ได้จากดาวเทียมพบว่ามีค่า
อุณหภูมิพ้ืนผิวอยู่ที่ 37.55 องศาเซลเซียส จากข้อมูลดังกล่าว สามารถแสดงได้ดังภาพที่ ภาพ 48 

 
ภาพประกอบที่ 48 ภาพแสดงความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยกับอุณหภูมิกรม

อุตุนิยมวิทยาเฉลี่ย 
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บทที่ 5 
สรุปและข้อเสนอแนะ 

การประยุกต์ใช้ระบบภูมิสารสนเทศภูมิศาสตรใ์นการศึกษาช่วงเวลาการเปลี่ยนแปลงของอุณหภูมิ
พ้ืนผิวในเทศบาลเมืองกาฬสินธุ์ ได้ท าการจ าแนกการใช้ประโยชน์ที่ดิน และหาค่าอุณหภูมิพ้ืนผิวดิน 
สามารถสรุปผลการวิจัย อภิปรายผล และข้อเสนอแนะ ได้ดังนี้ 
5.1 สรุปผลการทดลอง 

การศึกษาค่าอุณหภูมิพ้ืนผิวผิวจากข้อมูลดาวเทียมแลนด์แซท 8 ในเทศบาลเมืองกาฬสินธุ์ 
โดยหาความสัมพันธ์กับการใช้ประโยชน์ที่ดินพบว่า 

ในปี พ .ศ . 2556 มีพ้ืนที่เมืองมากที่สุดคิดเป็นร้อยละ 79.35 รองลงมาคือพ้ืนที่ป่าไม้คิดเป็น
ร้อยละ 11.37 เมื่อน ามาตรวจสอบความถูกต้องทางสถิติ พบว่ามีค่า สถิติแคปปา  ( Kappa Statistics) 
เท่ากับ 0.94 และค่าความถูกต้องโดยรวม (Overall Accuracy) เท่ากับร้อยละ 90.83 จากการวิเคราะห์
ความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยที่ดาวเทียมตรวจวัดได้มีค่าเท่ากับ 37.81 องศาเซลเซียส 
และอุณหภูมิพ้ืนผิวเฉลี่ยที่กรมอุตุนิยมวิทยาตรวจวัดได้มีค่าเท่ากับ 41.8 องศาเซลเซียส เมื่อน ามา
ค านวณหาความคลาดเคลื่อนพบว่ามีค่าเท่ากับ 9.55% 

ในปี พ .ศ . 2557 มีพ้ืนที่เมืองมากที่สุดคิดเป็นร้อยละ 77.24 รองลงมาคือพ้ืนที่ป่าไม้คิดเป็น
ร้อยละ 12.96 เมื่อน ามาตรวจสอบความถูกต้องทางสถิติ พบว่ามีค่า สถิติแคปปา  ( Kappa Statistics) 
เท่ากับ 0.95 และค่าความถูกต้องโดยรวม (Overall Accuracy) เท่ากับร้อยละ 92.50 จากการวิเคราะห์
ความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยที่ดาวเทียมตรวจวัดได้มีค่าเท่ากับ 38.69 องศาเซลเซียส 
และอุณหภูมิพ้ืนผิวเฉลี่ยที่กรมอุตุนิยมวิทยาตรวจวัดได้มีค่าเท่ากับ 39.69 องศาเซลเซียส เมื่อน ามา
ค านวณหาความคลาดเคลื่อนพบว่ามีค่าเท่ากับ 2.06% 

ในปี พ .ศ . 2558 มีพ้ืนที่เมืองมากที่สุดคิดเป็นร้อยละ 75.03 รองลงมาคือพ้ืนที่ป่าไม้คิดเป็น
ร้อยละ 16.07 เมื่อน ามาตรวจสอบความถูกต้องทางสถิติ พบว่ามีค่าสถิติแคปปา  ( Kappa Statistics) 
เท่ากับ 0.94 และค่าความถูกต้องโดยรวม (Overall Accuracy) เท่ากับร้อยละ 90.83 จากการวิเคราะห์
ความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยที่ดาวเทียมตรวจวัดได้มีค่าเท่ากับ 42.43 องศาเซลเซียส 
และอุณหภูมิพ้ืนผิวเฉลี่ยที่กรมอุตุนิยมวิทยาตรวจวัดได้มีค่าเท่ากับ 41.80 องศาเซลเซียส เมื่อน ามา
ค านวณหาความคลาดเคลื่อนพบว่ามีค่าเท่ากับ 1.41% 

ในปี พ .ศ . 2559 มีพ้ืนที่เมืองมากที่สุดคิดเป็นร้อยละ 75.92 รองลงมาคือพ้ืนที่การเกษตรคิด
เป็นร้อยละ 12.46 เมื่อน ามาตรวจสอบความถูกต้องทางสถิติ พบว่ามีค่าสถิติแคปปา  ( Kappa 
Statistics) เท่ากับ 0.93 และค่าความถูกต้องโดยรวม (Overall Accuracy) เท่ากับร้อยละ 89.17 จาก
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การวิเคราะห์ความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยที่ดาวเทียมตรวจวัดได้มีค่าเท่ากับ 37.22 องศา
เซลเซียส และอุณหภูมิพ้ืนผิวเฉลี่ยที่กรมอุตุนิยมวิทยาตรวจวัดได้มีค่าเท่ากับ 36.70 องศาเซลเซียส 
เมื่อน ามาค านวณหาความคลาดเคลื่อนพบว่ามีค่าเท่ากับ 1.41% 

ในปี พ .ศ . 2560 มีพ้ืนที่เมืองมากที่สุดคิดเป็นร้อยละ 80.70 รองลงมาคือพ้ืนที่ป่าไม้คิดเป็น
ร้อยละ 10.67 เมื่อน ามาตรวจสอบความถูกต้องทางสถิติ พบว่ามีค่าสถิติแคปปา  ( Kappa Statistics) 
เท่ากับ 0.92 และค่าความถูกต้องโดยรวม (Overall Accuracy) เท่ากับร้อยละ 88.33 จากการวิเคราะห์
ความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยที่ดาวเทียมตรวจวัดได้มีค่าเท่ากับ 33.46 องศาเซลเซียส 
และอุณหภูมิพ้ืนผิวเฉลี่ยที่กรมอุตุนิยมวิทยาตรวจวัดได้มีค่าเท่ากับ 34.70 องศาเซลเซียส เมื่อน ามา
ค านวณหาความคลาดเคลื่อนพบว่ามีค่าเท่ากับ 3.57% 

ในปี พ .ศ . 2561 มีพ้ืนที่เมืองมากที่สุดคิดเป็นร้อยละ 82.97 รองลงมาคือพ้ืนที่การเกษตรคิด
เป็นร้อยละ 10.79 เมื่อน ามาตรวจสอบความถูกต้องทางสถิติ พบว่ามีค่าสถิติแคปปา  ( Kappa 
Statistics) เท่ากับ 0.95 และค่าความถูกต้องโดยรวม (Overall Accuracy) เท่ากับร้อยละ 92.50 จาก
การวิเคราะห์ความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยที่ดาวเทียมตรวจวัดได้มีค่าเท่ากับ 41.49 องศา
เซลเซียส และอุณหภูมิพ้ืนผิวเฉลี่ยที่กรมอุตุนิยมวิทยาตรวจวัดได้มีค่าเท่ากับ 36.10 องศาเซลเซียส 
เมื่อน ามาค านวณหาความคลาดเคลื่อนพบว่ามีค่าเท่ากับ 14.94% 

ในปี พ .ศ . 2562 มีพ้ืนที่เมืองมากที่สุดคิดเป็นร้อยละ 88.48 รองลงมาคือพ้ืนที่การเกษตรคิด
เป็นร้อยละ 5.97 เมื่อน ามาตรวจสอบความถูกต้องทางสถิติ พบว่ามีค่าสถิติแคปปา  ( Kappa 
Statistics) เท่ากับ 0.95 และค่าความถูกต้องโดยรวม (Overall Accuracy) เท่ากับร้อยละ 86.67 จาก
การวิเคราะห์ความสัมพันธ์ระหว่างอุณหภูมิพ้ืนผิวเฉลี่ยที่ดาวเทียมตรวจวัดได้มีค่าเท่ากับ 37.55 องศา
เซลเซียส และอุณหภูมิพ้ืนผิวเฉลี่ยที่กรมอุตุนิยมวิทยาตรวจวัดได้มีค่าเท่ากับ 38.50 องศาเซลเซียส 
เมื่อน ามาค านวณหาความคลาดเคลื่อนพบว่ามีค่าเท่ากับ 2.46% 

5.2 อภิปรายผล 
การศึกษาช่วงเวลาการเปลี่ยนแปลงของอุณหภูมิพ้ืนผิวในเทศบาลเมืองกาฬสินธุ์  จากข้อมูล

ดาวเทียมแลนด์แซท 8 ร่วมกับการใช้ประโยชน์ที่ดิน พบว่าเทศบาลเมืองกาฬสินธุ์ยังคงเป็นพ้ืนที่เมือง
มากที่สุดถึงร้อยละ 88.48 รองลงมาคือพ้ืนที่ป่าไม้ แต่เมื่อวิเคราะห์ความสัมพันธ์ระหว่างพ้ืนที่เมืองกับ
อุณหภูมิพ้ืนผิว พบว่าพ้ืนที่ดังกล่าวมีอิทธิพลต่อการเพ่ิมข้ึนของอุณหภูมิเฉลี่ยในพ้ืนที่ ยิ่งมีการขยายตัว
ของพ้ืนเมืองมากขึ้นเท่าไร ก็จะส่งผลให้อุณหภูมิเพ่ิมสูงขึ้นเท่านั้น และเมื่อวิเคราะห์สมการถดถอยเชิง
เส้น เพ่ือตรวจสอบความถูกต้องของค่าอุณหภูมิที่ตรวจวัดได้ พบว่าเส้นกราฟมีการขึ้นลงจึงซึ่งสันนิ
ฐานได้ว่าต าแหน่งที่วัดอุณหภูมิของกรมอุตุนิยมวิทยาของพ้ืนที่จังหวัดกาฬสินธุ์นั้นมีเพียงต าแหน่ง
เดียว ซึ่งตั้งอยู่ที่ ต .หลักเมือง อ.กมลาไสย จ.กาฬสินธุ์ ดังนั้นข้อมูลของอุณหภูมิที่ได้มาจากต าแหน่ง
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เดียวนั้นไม่สามารถเป็นตัวแทนของข้อมูลอุณหภูมิของพ้ืนที่ศึกษาได้ ซึ่งข้อมูลที่วิเคราะห์ได้จากข้อมูล
ดาวเทียมนั้นเป็นการวิเคราะห์จากพ้ืนที่ทุกตารางนิ้วของพ้ืนที่ศึกษา จึงท าให้อุณหภูมิที่วิเคราะห์ได้
เมีความคลาดเคลื่อบ้างเล็กน้อย 

5.3 ปัญหาและอุปสรรค 
1. หาช่วงเวลาของการบันทึกภาพถ่ายดาวเทียมในช่วงเดียวกันแต่ต่างปีไม่ค่อยพบ ท าให้มี 

ตัวเลือกน้อยลงในการเลือกช่วงเวลาของการบันทึกภาพถ่ายดาวเทียม 

2. ในการจ าแนกข้อมูลในบางครั้งโปรแกรมสารสนเทศภูมิศาสตร์มีปัญหา ควรเลือกใช้โปรแกรม 

สารสนเทศภูมิศาสตร์ให้เหมาะสมกับข้อมูล 

5.4 ข้อเสนอแนะ  
1. ควรเลือกภาพถ่ายที่ไม่มีเมฆหรือมีเมฆปกคลุมพ้ืนที่ศึกษาน้อยที่สุดเพ่ือความถูกต้องของ 

ผลการข้อมูล เพราะถ้ามีเมฆอยู่ในภาพถ่ายดาวเทียมในพื้นศึกษาที่จะท าการจ าแนกผลมีความถูกต้อง
ลดลงหรือมีผลที่คลาดเคลื่อน 

2. อุณหภูมิที่มีการข้ึนลงอาจจะเป็นเพราะว่าโลกของเราช่วงที่ผ่านมานั้นมีการเปลี่ยนแปลง 

ไป อย่างมาก บางปีมีอุณหภูมิที่ร้อนถึงร้อนมาก บางปีมีอุณหภูมิที่หนาวถึงหนาวมาก 
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